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Chapter 1: Introduction
l "Welcome to PPM Operational Reporting" below

l "Audience for this Document" below

l "Related Documents" on the next page

l "Operational Reporting Content on HP Live Network" on page 10

Welcome to PPM Operational Reporting
Operational Reporting for Project and Portfolio Management Center (PPM Center) enables you to
provide rich, interactive reports on PPM Center data. You can use it to distribute weekly reports, provide
customers with personalized service offerings, or to integrate business-critical information into
corporate portals.

This document provides details about how to use BusinessObjects' web desktop tool InfoView to
generate operational reports on Project Management, Resource Management, HP Time Management,
and Financial Management data. The chapters include descriptions of the preconfigured operational
reports that HP supplies with the solution and instructions on how to run them, cover some of the ad
hoc reports that you can create for PPM Center data, and provide detailed examples of how to create
the Web Intelligence documents and construct queries for ad hoc reports.

PPM Center version 9.30 provides Excel version of the above reports that HP supplies with Operational
Reporting. This document details on how to use these Excel reports from within PPM Center without
using BusinessObject.

Note: New development of PPM Center reports will continue to expand on this new Operational
Reporting platform.

Audience for this Document
This document is written for PPM Center users, particularly users who act as direct managers, resource
managers, and project managers. Readers are assumed to be familiar with the functionality of all PPM
Center products and with SAP BusinessObjects.
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Related Documents
This section lists the HP and SAP BusinessObjects documents that contain useful information for
Operational Reporting users. HP provides the relevant SAP BusinessObjects guides in PDF format on the
HP Operational Reporting software CD. For information about how to obtain the HP documents listed,
see "Accessing PPM Center Documentation" below.

The following HP documents provide useful information for Operational Reporting users:

l Release Notes

l Operational Reporting Administrator’s Guide

l Data Model Guide(provides details about the internal structure of the data models for both PPM
Center and Operational Reporting)

l Reports Guide and Reference

l Project Management User’s Guide

l Financial Management User’s Guide

l Resource Management User’s Guide

l Time Management User’s Guide

l HP-Supplied Entities Guide(includes descriptions of all portlets, request types, and workflows in PPM
Center)

For detailed information about SAP BusinessObjects Enterprise, see your SAP documentation.

Accessing PPM Center Documentation
To obtain all of the HPPPM Center documentation, go to the HP Software Product Manuals Web site
(https://softwaresupport.hp.com). To access this Web site, you must first set up an HP Passport
account.
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Operational Reporting Content on HP Live Network
HP Live Network (HPLN) is an online virtual community for product experts, partners, and customers to
collaborate and share knowledge, best practices, and add-on content for HP software products,
including PPM Center and Operational Reporting. You can log in to the Operational Reporting community
page on HPLN to access the latest news, updates, and documentation for Operational Reporting. You
can browse from the Operational Reporting community page or subscribe to receive notifications via
email.

Accessing to Operational Reporting Content on HPLN
Access to HPLN is free to all PPM Center customers. You must have an HP passport account to access
the PPM Center and Operational Reporting community pages.

You can visit the following web site to access to the Operational Reporting Content:
https://hpln.hp.com/group/operational-reports-content-project-and-portfolio-management

Note: Only project owners and administrators can post to the Announcements forum. If you are not
a project owner or administrator, direct your feedback to the project owner or the general
discussion forum.

l To obtain the latest news and updates of Operational Reporting, go to the Overview or
Announcements tab.

l To download the Operational Reporting bundles and documents, go to the Downloads tab.

l To launch discussion about the use of Operational Reporting, go to the Forums tab.

l To subscribe to email notifications about Operational Reporting, click Subscribe in the Overview,
Announcements, or Downloads tab, and then select what you want to subscribe.
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Chapter 2: Using Excel Reports for Operational
Reporting
This chapter provides instructions on how to use the Excel version of the reports that HP supplies with
Operational Reporting from PPM Center without using BusinessObjects.

The HP-supplied Excel reports include:

l Demand VS Capacity report

l Project Status List report

l Financial Summary report

l Time Sheet Compliance report

l ETL Job History report

Software Requirements
You should meet the following requirements to use HP-supplied Excel reports:

l PPM Center version 9.30

For instructions about installing PPM Center version 9.30, see Installation and Administration Guide.

For instructions about upgrading to PPM Center version 9.30, see Upgrade Guide.

l Operational Reporting Content Pack 2.0

For information about installing or upgrading to Operational Reporting Content Pack 2.0, see
Operational Reporting Administrator’s Guide for Content Pack 2.0.

l Microsoft Excel® 2007-2013
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Configuring to Use Excel Reports on PPM Center
To use the Excel reports for Operational Reporting from PPM Center, you should add the following
server configuration parameters into the server.conf file. For information about editing the
server.conf file, see Installation and Administration Guide.

Parameter Name Description

REPORTING_JDBC_URL Locator for the database that contains the
Operational Reporting database schema.

REPORTING_DB_USERNAME Username for the Operational Reporting
database schema.

REPORTING_DB_PASSWORD Password for the Operational Reporting
database schema.

Note: You can encrypt the Operational Reporting database password as you do for PPM database
password. For more information about encrypting passwords, see Installation and Administration
Guide.

Running Excel Reports
You can run Excel reports for Operational Reporting as you run other PPM Center reports from the PPM
Center standard interface.

For information about how to run reports, see Reports Guide and Reference.

Demand VS Capacity Report
This report lists resource demand for specified resource pools as well as allocation and available
capacity of each resource pool.
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For descriptions of these parameters, see the table in "Running the Demand Vs Capacity Report" on
page 60.

Project Status List Report
This report displays a list of projects with detailed status information.

For descriptions of the parameters of this report, see the table in "Running the Project Status List
Report" on page 19.

Financial Summary Report
This report compares current, forecast and approved financial information for a specified period.

Operational Reporting User's Guide
Chapter 2: Using Excel Reports for Operational Reporting

HP Project and Portfolio Management Center (Content Pack 2.0, on PPM Center 9.30) Page 13 of 131



For descriptions of the parameters of this reports, see the table in "Running the Financial Summary
Report" on page 105.

Time Sheet Compliance Report
This report shows time sheet submission and approval compliance for resource pools and org units with
specified period.

For descriptions of the parameters of this reports, see "Table 5-1. Prompts for the Time Sheet
Compliance Report query" on page 85

ETL Job History Report
This report displays detialed ETL history information
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The parameters of this reports are described as follows:

Field Name Description

Enter value(s) for
Batch Id:

Batch ID to filter on ETL job history

Enter value(s) for Etl
Name:

Searches for ETL job history of specified ETL job name

Enter Job Start Date Searches for ETL job history which starts after the specified date

Enter Job End Date Searches for ETL job history which ends before the specified date

Enter value(s) for
Status

Searches for ETL job history with the specified statuses
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Chapter 3: Using BusinessObjects for Operational
Reports
This chapter provides instructions on how to use BusinessObjects' web desktop tool InfoView to run
reports that HP supplies with Operational Reporting and how to create ad hoc operational reports.

These HP-supplied reports include:

l Project Status List report for Project Management data

The Project Status List report includes the following linked reports:

o Project Status Detail report

o Project Issues report

o Project Risks report

o Project Scope Changes report

l Demand Vs Capacity report, for Resource Management data

l Time Sheet Compliance report, for HP Time Management data

l Financial Summary report, for Financial Management data

You can use these HP-supplied reports to quickly run a report query that generates clear data that are
easy to interpret, even if you have limited knowledge of BusinessObjects and InfoView. Each of these
preconfigured reports is a Web Intelligence document that you can view and work with using
BusinessObjects' Web desktop InfoView.

Each of the HP-supplied reports has an associated set of prompts that you can use as configured or
modify to filter your data differently. These reports are designed for typical use-case scenarios and are
described fully in later chapters.

Logging On to BusinessObjects InfoView
To log on to BusinessObjects InfoView:
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1. Go to the InfoView URL that your reporting administrator provides. The URL

http://<BusinessObjects_Server_Name_or_IP>:8080/InfoViewApp/logon.jsp

2. In the User Name box, type the user name provided by your reporting administrator.

3. In the Password box, type the password provided by your reporting administrator.

4. Click Log On.
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Setting the Locale for Multilingual Operational
Reporting
If your organization has multilingual Operational Reporting enabled and you are viewing non-English
instances of InfoView, then you must configure InfoView to display numeric values and dates in your
operational reports correctly for your locale.

To make sure that numeric values and dates are correctly displayed for your locale, do the following:

1. Open a web browser window and log on to InfoView.

2. Click Preferences.

3. In the General section of the Preferences page, scroll down and, from the Preferred Viewing
Locale list, selecta locale.

4. Click OK.

When you start viewing operational reports in InfoView, dates and numeric values are displayed
correctly.

Reporting on Project Management
l "About this Chapter" below

l "Project Status List Report" on the next page

l "Ad Hoc Reports for Project Management" on page 35

About this Chapter
This chapter covers Operational Reporting for Project Management. It provides information about the
preconfigured Project Status report, which HP supplies, and some of the many the ad hoc reports that
you can create for your Project Management data.

Note: If you organization has multilingual Operational Reporting enabled, make sure that you
configure InfoView to display your operational report data correctly for your locale. For instructions,
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see "Using BusinessObjects for Operational Reports" on page 16.

Project Status List Report
The Project Status List report that HP supplies with Operational Reporting is designed to help you review
and manage all of your PPM Center projects. This report can include various project header attributes,
such as project health, region, project type and percent complete, as well as effort and cost fact
information at the project level, as captured in the workplans assigned to projects. To view additional
information about a particular project, you can drill down on specific report results to see underlying
details such as project health, major milestones, issues, risks, and scope changes.

Grouping Report Data

You can group project information presented in the report based on region, project class, project type,
business unit, or program.

Selected Grouping Data Displayed

Region Regions associated with projects

Project Class Class to which projects belong. For example, projects that belong to
the Core ("Keep the Lights On") project class serve to maintain
existing business applications and services.

Project Type Entity that determines the business rules used to manage a project.
Project types include policies for different aspects of managing the
project, including:

l What types of actuals are collected

l Whether built-in project costing or HP Time Management is used
for the project

l Whether the project includes a work plan

Business Unit Business unit responsible for the project

Program Programs associated with projects

Table 3-1. Data display in the Project Status List report based on grouping

Running the Project Status List Report

To run the Project Status List Report:
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1. Log on to InfoView and open the Document List.

Note: The folders and objects visible in the document list vary, depending on the account you
logged on to, the rights that your BusinessObjects Enterprise administrator granted to you,
and the settings that you and your administrator enable.

2. In the Tree panel, expand the Public Folders folder, and then select HP PPM Reports.

3. In the Title section, double-click Project Status List Report.
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The Prompts dialog box lists the filters that are available for the report query. All filters for which
values are required have default values, but you can change these values, and specify values for
any or all of the optional filters listed.

Note: A green check mark ( ) to the left of a prompt indicates that a value (or values) is

specified for the prompt. A red arrow ( ) to the left of a prompt indicates that the filter is

required and you must specify a value for it before you can run the report query.

4. Run the query as it is or, to filter the data further, before you run the report, provide information
for the prompts listed and described in the following table.

Note: If you do not specify a value for a prompt, the prompt is not used to filter report data.
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Prompt

* Required Description

*Primary Grouping Primary grouping for project information in the report results

Selections include:

o Region

o Projects Class

o Project Type

o Business Unit

o Program

Project Name Name of the PPM Center project

Overall Health Weighted average of the health indicators for scheduling, cost and
earned value health, and issue health for a project

Region Name Name of the region with which the project is associated

Request Type Project control request type associated with the project. This can be a
project issue, risk, or scope change.

Project Type Entity that determines the business rules used to manage a project.
Project types include policies for different aspects of managing the
project, including:

o What types of actuals are collected

o Whether built-in project costing or HP Time Management is used
for the project

o Whether the project includes a work plan

Business Unit Business unit responsible for the project

Project Class Indicates the class to which the project belongs. For example, projects
that belong to the Core (Keep the Lights On) project class serve to
maintain existing business applications and services.

Project Status Status of the project in its assigned process
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Prompt

* Required Description

Program Name Name of the program with which the project is associated

Project Manager Name of the manager assigned to the project

5. After you finish specifying data filters, run the query.

Web Intelligence retrieves the data for the default values and returns the report results.

Project Status List Report Results

"Figure 3-1. Project Status List Report results" below shows the results of the Project Status List report.

Figure 3-1. Project Status List Report results

"Table 3-2. Columns displayed in the Project Status List report" below lists descriptions of the columns
displayed in the Project Status List report.

Column Description

<Grouping> Primary grouping selected for report data. You can group all report data
by Region, Project Class, Project Type, Business Unit, or Program.

Project No. PPM Center-assigned number that uniquely identifies the project

Table 3-2. Columns displayed in the Project Status List report
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Column Description

Project Name Project name

Project Manager Resource assigned to manage the project

Status Status of the project in its assigned process

Health

l Overall

l Schedule

l Issue

l Cost

Color codes that indicate whether an aspect of the project (schedule or
cost, for example) is in a critical state (red), at risk (yellow), or just where
it should be, as planned (green).

Actual Start Date Calendar date on which project work actually started

Actual Finish Date Calendar date on which project work actually finished

Planned Start Period Calendar period during which project work is scheduled to start

Planned Finish Period Calendar period during which project work is scheduled to finish

Description Project description

Request Type Type of request used to initiate the project

Business Unit Business unit responsible for the project

Business Objective Name Business objective associated with the project

Project Class Class to which the project belongs. For example, projects that belong to
the Core (Keep the Lights On) project class serve to maintain existing
business applications and services.

Project Type Project type

Region Region associated with the project

SPI Schedule performance index. Refers to the schedule efficiency ratio of
earned value to planned value. SPI describes what portion of the work
plan or planned schedule has been accomplished in terms of its cost.

CPI Cost performance index. Refers to the cost efficiency ratio of earned
value to actual cost. CPI is used to calculate the projected actual cost for
a project and predict the size of possible cost overrun.

Table 3-2. Columns displayed in the Project Status List report, continued
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Column Description

Capital

l Labor

l Non-Labor

l Total

Capital cost of the project

Operating

l Labor

l Non-Labor

l Total

Operating cost of the project

% Complete Percent of the project work completed to date

Table 3-2. Columns displayed in the Project Status List report, continued

Project Status Details Report

To view the detailed data that underlie the information shown for a project listed in the Project Status
List Report:

l In the Project No. column of the Project Status List Report, click the link for a project for which you
want to see more detailed data.
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The Project Status Details Report opens in a new browser window.

"Table 3-3. Fields displayed in the Project Status Details report" below lists the fields displayed in the
Project Status Details report.

Field Description

Project Details

Project No. PPM Center-assigned number that uniquely identifies the project

Project Name Project name

Project Type Project type

Planned Period Fiscal calendar period during which project work is scheduled to be active

Table 3-3. Fields displayed in the Project Status Details report
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Field Description

Actual Dates Calendar date (mm/dd/yyyy) on which project work actually started and, if
the project is completed, the date on which it was completed

Creation Date Calendar date (mm/dd/yyyy) on which the project was created

Created by Name of the resource who created the project

Project Class Class to which the project belongs. For example, projects that belong to
the Core (Keep the Lights On) project class serve to maintain existing
business applications and services.

Asset Class Asset class to which the project belongs

Project Manager(s) Resource(s) assigned to manage the project

Associated Programs Programs with which the project is associated

Region Region associated with the project

Business Unit Business unit to which the project belongs

Business Objective Business objective associated with the project

Status Status of the project in its assigned process

Description Project description

% Complete Percent of the project work completed to date

SPI Schedule performance index. Refers to the schedule efficiency ratio of
earned value to planned value. SPI describes what portion of the work
plan or planned schedule has been accomplished in terms of its cost.

CPI Cost performance index. Refers to the cost efficiency ratio of earned
value to actual cost. CPI is used to calculate the projected actual cost for
a project and predict the size of possible cost overrun.

Health Indicators

Health

l Overall Health

l Schedule Health

l Issue Health

Color codes that indicate whether an aspect of the project (schedule or
cost, for example) is in a critical state (red), at risk (yellow), or just where
it should be, as planned (green)

Table 3-3. Fields displayed in the Project Status Details report, continued
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Field Description

l Cost Health

Priority Priority assigned to the project, if any

Issues Number of issue requests submitted against the project. If any issues are
associated with the project, then the details for these requests are
provided on the Project Issues tab. For information about the Project
Issues tab, see "Project Issues Tab" on the next page.

Risks Number of risk requests submitted against the project. If any risks are
associated with the selected project, then the details for these are
provided on the Project Risks tab.
For information about the Project Risks tab, see "Project Risks Tab" on
page 31.

Scope Changes Number of scope change requests submitted against the project. If any
scope changes are associated with the project, then the details for these
are provided on the Project Scope Changes tab. For information about
the Project Scope Changes tab, see "Project Scope Changes Tab" on
page 33.

Cost Information

Capital

l Labor

l Non-Labor

l Total

Capital cost of the project

Operating

l Labor

l Non-Labor

l Total

Operating cost of the project

Workplan Milestones

Milestone Names of standard milestones in the workplan assigned to the project

Major Milestone Names of milestones identified as a major milestones in the workplan
assigned to the project

Table 3-3. Fields displayed in the Project Status Details report, continued
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Field Description

%Complete Percent of the project work completed toward reaching the milestone

Estimated Date Date on which the project is expected to complete the milestone

Table 3-3. Fields displayed in the Project Status Details report, continued

If any issues, risks, or scope changes requests are associated with the selected project, then the details
for these requests are provided on the Project Issues, Project Risks and Project Scope Changes tab.
These tabs are described in the following sections.

Project Issues Tab

If project issue requests have been submitted against the project you selected in the Project Status List
report, the number of issues is listed in the Issues column at the bottom of the Project Detail report.

To view all project issues, click the Project Issues tab.

To view detailed information about an issue listed on the Project Issues tab, click its link in the Request
No. column. The Issue Details window opens in a new browser window.
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"Table 3-4. Fields displays on the Issue Details tab" below lists the fields shown on the Issue Details tab
for a selected issue.

Field Description

Request No. Project issue request number in PPM Center

Escalation Level Escalation level of the issue. Possible values are Project or Program.

Priority Priority value assigned to the project issue request

Status Project issue request status

Created By Name of the resource who submitted the request

Application Application associated with the request

Department Department associated with the project issue request

Request Type Name Name of the request type

Description Description of the project issue

Workflow Name Name of the workflow assigned to the project issue request

Active Workflow Step Name Current workflow step reached by the request

Assigned To Name of the resource assigned to the request

Contact Name Name of the contact (if any) assigned to the request

Table 3-4. Fields displays on the Issue Details tab
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Project Risks Tab

If project risk requests have been submitted against the project selected in the Project Status List
report, the number of risks is listed in the Risks column at the bottom of the Request Detail report.

To view all project risks, click the Project Risks tab.

To view detailed information about an issue listed on the Project Risks tab, click its link in the Request
No. column. The Risk Details window opens in a new browser window.
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"Table 3-5. Fields displays on the Risk Details tab" below lists the fields shown on the Risk Details tab
for a selected risk.

Field Description

Request No. Project risk request number in PPM Center

Probability Estimated probability of the risk occurring

Risk Impact Level Impact level assigned to the risk

Priority Priority value assigned to the project risk request

Status Current project risk request status

Created By Name of the resource who submitted the request

Application Application associated with the request

Department Department associated with the request

Request Type Name Name of the request type

Description Description of the project risk

Workflow Name Name of the workflow assigned to the request

Active Workflow Step Name Current workflow step reached by the request

Table 3-5. Fields displays on the Risk Details tab
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Field Description

Assigned To Name of the resource assigned to the request

Contact Name Name of the contact (if any) assigned to the request

Table 3-5. Fields displays on the Risk Details tab, continued

Interpreting Cost Information in the Project Status List Report and the Project
Status Detail Report

In PPM Center, tracking of capitalizable costs is turned on via the COST_CAPITALIZATION_ENABLED
server configuration parameter. Each PPM Dashboard page that displays cost information behaves
according to this setting. Operational Reporting, however, does not check the COST_CAPITALIZATION_
ENABLED parameter. If the PPM Center instance is not set up to track Capital Cost, then a report
displays empty Capital Cost fields, and displays Actual Cost as Operating Cost.

Project Scope Changes Tab

If project scope change requests have been submitted against the project selected in the Project Status
List report, the number of scope changes is listed in the Scope Changes column at the bottom of the
Project Status Detail report.

To view the details for a scope change request listed in the Scope Changes column, click its request
number. The Scope Changes tab displays the Request Detail report for the scope change request.

To view detailed information about a scope change listed on the Scope Changes tab, click its link in the
Request No. column. The Scope Change Details window opens in a new browser window.
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"Table 3-6. Fields displays on the Scope Change Details tab" below lists the fields shown on the Scope
Change Details tab for a selected scope change request.

Field Description

Request No. Scope change request number in PPM Center

Impact Severity Impact severity assigned to the project scope change request

CR Level Change request level assigned to the project scope change request

Priority Priority value assigned to the project scope change request

Status Current project scope change request status

Created By Name of the resource who submitted the request

Application Application associated with the request

Department Department associated with the request

Request Type Name Name of the request type

Description Description of the scope change risk

Workflow Name Name of the workflow assigned to the request

Active Workflow Step Name Current workflow step reached by the request

Assigned To Name of the resource assigned to the request

Contact Name Name of the contact (if any) assigned to the request

Table 3-6. Fields displays on the Scope Change Details tab
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Ad Hoc Reports for Project Management
This section provides information about the ad hoc operational reports that you can create for Project
Management, and includes examples on how to create a few of these reports. It provides information
about the contexts available for the reports, recommendations on creating the ad hoc reports, and
includes guidance on how to use PPM Center universe objects in operational report queries.

Contexts for Ad Hoc Reports for Project Management

When you create an ad hoc report for Project Management, InfoViewmay prompt you to select a
context for your report query. A context consists of a set of well-defined joins that create a unique
query path involving multiple dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a common set of dimensions,
the joins between multiple facts and the related dimensions result in a loop. By providing separate
contexts for each fact and the related dimensions, the loop is eliminated so that you can query multiple
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports you create for Project
Management data:

Context Usage

Actual effort for a task by resource Use this context if you want the report to show actual
effort submitted by resources against tasks. In this
context, the region refers to the resource's region.

Cost at task level Use this context if you want the report to show the cost of
project tasks for a given workplan, or if you want to
report on all of the tasks and attributes of a project. You
can also use this context to compare current cost with
baseline cost.

Effort aggregated by summary task Use this context if you want the report to show effort
information aggregated by summary task

Project Managers Use this context when you want to search projects by
project managers in your report, or you just want to
report on project and task attributes in the workplan.

Scheduled effort for a task by assigned Use if you want the report to show scheduled effort for

Table 3-7. Fields displays on the Scope Change Details tab
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Context Usage

resource resources assigned to a task. In this context region refers
to the project's region

Unassigned effort for tasks Use this context if you want the report to show
unassigned effort for tasks or if you want the report to
list all of the tasks and associated attributes for a project
with a specific assigned workplan.

Table 3-7. Fields displays on the Scope Change Details tab, continued

Best Practices for Reporting on Project Management Data

This section provides recommendations for getting the best results from the ad hoc operational reports
you create for your Project Management data.

Segregating Project Manager Name from Effort and Cost Measures

Do not build queries that include effort or cost measures along with the Project Manager object. If a
project has multiple managers, doing so may result in incorrect effort and cost totals.

If the sole purpose of the report is to display the effort and cost associated with each project manager,
then use the All Project Managers object in the query and use the Project Manager object to create a
filter to search by project manager name. If you still want to use the Project Manager object with effort
and cost measures, then build separate queries, one that has the measures with other relevant
dimensions, and another query for project and project managers information.

Summary Tasks with No Actual Effort Logged: Missing Region Information

If your report query includes the task dimension, effort measures, and the region dimension, the
resulting report does not display region information for summary tasks that have no actual effort
logged against them. The relationship between the region dimension and effort and cost measures is
intended for use at a higher level (for example, project level) than task level.

Summary Tasks with No Actual Effort Logged: Extra Row in Report Results

If you build a report query that includes task attributes, project attributes, resource name, and all effort
measures (actual, assigned schedule, unassigned schedule, estimated remaining effort), the report
results include an extra row with the resource name "Not Assigned" for summary tasks for which no
actual effort is logged.
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If you do not want this extra row in your report results, add a filter condition to the query to eliminate
the extra row, or modify the generated query to make the outer join between Task dimension to Effort
facts an inner join instead of an outer join (done in the PM Derived Universe by default).

Reporting on Effort for Multiple Tasks with the Same Name for a Given
Project

BusinessObjects groups the facts by all of the dimensions in the query to present the aggregated
measures correctly. This means that if all the dimensions provided for the effort measures are the
same, those dimensions are grouped together.

If you want to create a report on effort measures for project tasks, keep in mind that if some tasks for
a given project have same name, then the total effort reported may be summed incorrectly. To avoid
this problem, make sure that your queries include an attribute such as parent task name to distinguish
between tasks with the same name.

Reporting on Estimated Remaining Effort for Projects

To create reports that show reliable estimates of remaining effort for projects, set the Track Estimated
Remaining Effort flag in your project settings when you create projects.

If you include the Estimated Remaining Effort object in the Results section of a report query, use the
Track ERE object as follows:

=If([Track ERE] = 1) Then [Estimated Remaining Effort] Else ""

Interpreting Cost Values in Operational Reports

In PPM Center, an administrator can enable the tracking of capitalizable costs by setting the COST_
CAPITALIZATION_ENABLED server configuration parameter to true. Each PPM Center page that
displays cost information checks this setting. However, Operational Reporting does not check this
configuration setting.

If the PPM Center instance is not set up to track capital cost, then actual cost shows up under the
Operating Cost in operational reports. PPM Center allows administrators to change the COST_
CAPITALIZATION_ENABLED parameter setting even after a user has submitted capitalized cost for a
project. But because Operational Reporting does not check the COST_CAPITALIZATION_ENABLED
parameter setting, operational reports display capital cost if a user has already entered the capitalized
cost for that project, regardless of how COST_CAPITALIZATION_ENABLED is set on the PPM Center
instance.
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Creating Ad Hoc Reports for Project Management

The PM Derived Universe delivered with PPM Center includes classes and objects that enable you to
create your own operational reports for Project Management data. The following are just some of the
ad hoc reports that you can create for your Project Management data:

l "Project Tasks Running Behind Schedule" on the next page

l "All Effort by Project" on page 44

l "Project Effort by Task" on page 45

l "Project Effort by Resource" on page 47

l "Regional Distribution of Actual and Scheduled Effort for a Given Project" on page 48

l "Project Tasks that Start and Finish in the Next Week" on page 49

l "Comparison of Current Workplan and Baseline Workplan Attributes" on page 50

l "Total Scheduled Effort Vs Actual Effort" on page 53

This section includes instructions on how to create one such report and provides descriptions of other
ad hoc reports that you can create for Project Management.

Ad Hoc Report on Project Management Data: Example

You can create a report that shows which projects are running behind schedule. "Table 3-8. PM Derived
Universe objects to include in a report on projects running behind" below shows the PM Derived Universe
objects to use to create this Project Tasks Starting and Ending report, and where to place them on the
NewWeb Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Tasks Task Name

Task Scheduled Finish Date

Task Estimated Finish Date

Project Effort Effort for Current WorkPlan

Table 3-8. PM Derived Universe objects to include in a report on projects running behind
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The following example includes very basic steps required to create and run this report query. For
detailed information about creating Web Intelligence documents, see the BusinessObjects Enterprise
InfoView User's Guide.

Project Tasks Running Behind Schedule

To create a report that shows which projects are running behind schedule:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section of the InfoView home page, click Document List.

Note: The folders and objects visible in the Document List depend on the account you logged
on to, the rights that your BusinessObjects Enterprise administrator granted to you, and the
settings that you and your administrator enable.

3. From the New list, select Web Intelligence Document.

4. From the list of available universes, select PM Derived Universe.
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5. A Warning - Security dialog box opens to advise you of a security concern related to Java
application components and to allow you to block potentially unsafe components. Click No.

The Data tab in the left pane lists all of the available classes and objects in the PM Derived
Universe.

6. Expand the Project Information class folder.

7. Drag the Project Name object to the Result Objects section on the right (top), and then drag the
Project Name object to the Query Filters section on the right (bottom).

8. In the Query Filters panel, click the list button ( ) at the right end of the Project Name box, and

then select Prompt.

9. On the Data tab, expand the Project Tasks class folder, and then drag the Task Name, Task
Scheduled Finish Date, and Task Estimated Finish Date objects to the Result Objects section.
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10. On the Data tab, expand the Project Effort class folder, and then drag the Effort for Current
WorkPlan object to the Query Filters section.

11. Click Run Query.

12. If, as in this case, the set of objects you select to construct your ad hoc report query can be
retrieved through multiple join paths, the Query Context dialog box opens and prompts you to
select a context for the query. Select Scheduled effort for a task by assigned resource, and then
click OK.

Note: To see how a context in the list affects report results, click the context name and read
the content displayed in the Description box.

For information about the contexts for reports on Project Management data, see "Contexts
for Ad Hoc Reports for Project Management" on page 35.

The Prompts dialog box opens.

13. Specify the projects to include in the report, and then click Run Query.

14. In addition to adding the objects listed in "Table 3-16. PM Derived Universe objects to include in a
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report that compares scheduled effort, actual effort, and estimated remaining effort for a
project" on page 53 to your report query, this report requires that you create a variable to find out
which project tasks have been delayed. To create the variable for delayed tasks:

a. In the Reporting toolbar, click Variable Editor.

b. In the Name box, type Delayed.

c. In the Qualification list, leave Dimension selected.
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d. In the Formula box, add the following formula:

=If([Task Estimated Finish Date]>
[Task Scheduled Finish Date]) Then "Y" Else("N")

e. Click OK.

15. On the Data tab, select the new Delayed variable.
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16. Drag the variable to the Report tab and insert it where you want the Delayed column displayed.

17. Provide a title for the report.

18. Name and save the document.

All Effort by Project

A report on all effort by project lets you view scheduled effort (assigned and unassigned), actual effort
and estimated remaining effort for selected projects. If you do not filter for a specific project or
projects, the report results include effort information for all projects.
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"Table 3-9. PM Derived Universe objects for a report that shows all effort, grouped by project" below
lists the PM Derived Universe objects to use to create an Effort by Project report.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Estimated Remaining Effort

Actual Effort

Effort for Current Workplan

Table 3-9. PM Derived Universe objects for a report that shows all effort, grouped by project

The following figure shows sample results for this report.

Project Effort by Task

You can create a Project Effort by Task report that shows scheduled effort (assigned and unassigned),
actual effort and estimated remaining effort associated with the tasks (summary and leaf) for a
selected project. This effort information is shown as an aggregated value for summary tasks. If you do
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not specify a project name as a report filter, then the report shows efforts for all projects at the task
level.

"Table 3-10. PM Derived Universe objects for a Project Effort by Task report" below lists the PM Derived
Universe objects to use to create a Project Effort by Task report.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list /Prompt

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Estimated Remaining Effort

Actual Effort

Effort for Current Workplan

Project Tasks Task Name

Task Type

Table 3-10. PM Derived Universe objects for a Project Effort by Task report

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

The following figure shows sample results for this report.
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Project Effort by Resource

You can create a Project Effort by Resource report that shows scheduled effort (assigned and
unassigned), actual effort, and estimated remaining effort associated with the tasks (summary and
leaf) by individual resources for a selected project. Effort value for summary tasks is not aggregated. If
you do not specify a project name as a report filter, then the report shows efforts for all projects at the
task level.

"Table 3-11. PM Derived Universe objects for a Project Effort by Resource report" below lists the PM
Derived Universe objects to use to create a Project Effort by Resource report.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Effort for Current Workplan

Table 3-11. PM Derived Universe objects for a Project Effort by Resource report
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Object Class Result Objects Query Filters / Operator / Filter Type

Estimated Remaining Effort

Actual Effort

Project Tasks Task Name

Task Type

Resources Resource

Table 3-11. PM Derived Universe objects for a Project Effort by Resource report, continued

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

Regional Distribution of Actual and Scheduled Effort for a Given Project

Amanager of a project with resources located in several different regions can create a report that
quickly provides an overview of the distribution of effort (unassigned scheduled effort, assigned
scheduled effort, and actual effort) across all of the regions. "Table 3-12. PM Derived Universe objects
to include in a report on the regional distribution of actual and scheduled effort for a project" below
shows the PM Derived Universe objects to use to create this report, and where to place them on the
NewWeb Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Region Region Name

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Actual Effort

Effort for Current WorkPlan

Table 3-12. PM Derived Universe objects to include in a report on the regional distribution of actual
and scheduled effort for a project

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.
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Project Tasks that Start and Finish in the Next Week

Amanager of multiple projects can create a report that shows all project tasks, scheduled start and end
dates for all tasks that are scheduled to start or end during the next week. A project manager can
group these report data by date or by project. "Table 3-13. PM Derived Universe objects to include in a
report on project tasks scheduled to start or end during the next week" below shows the PM Derived
Universe objects to use to create this Project Tasks Starting and Ending report, and where to place
them on the NewWeb Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Project
Information

Project Name Project Name / In list / Prompt

Project Tasks Task Name

Task Status

Task Scheduled Start
Date

Task Estimated Finish
Date

Task Scheduled Start Date / Between / Prompt And
Prompt

Task Estimated Finish Date e / Between / Prompt And
Prompt

Project
Workplans

Active Workplan

Project Effort Effort for Current WorkPlan

Table 3-13. PM Derived Universe objects to include in a report on project tasks scheduled to start
or end during the next week

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

Nest the objects in the Query Filters section as shown in the following figure.
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When the Query Context dialog box opens and prompts you to select a context for the query, select
Scheduled effort for a task by assigned resource

The following figure shows example results for a report on tasks scheduled to start or end during the
next week for a specific project.

Comparison of Current Workplan and Baseline Workplan Attributes

"Table 3-14. PM Derived Universe objects to include in a report that compares current and baseline
workplan attributes" on the next page shows the PM Derived Universe objects to use to create this
report, and where to place them on the NewWeb Intelligence Document page.
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Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Workplan Workplan Name

Workplan Type Name

Is Active / Equal to / Constant (Y)

Project Header Scheduled Duration

Scheduled Finish Date

Percent Complete

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Estimated Remaining Effort

Actual Effort

Table 3-14. PM Derived Universe objects to include in a report that compares current and baseline
workplan attributes

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

The following figure shows example results for a report designed to compare current workplan and
baseline workplan attributes.

Project Status by Project Manager

You can create a report that lets you quickly see the current status and health of projects assigned to
project managers. "Table 3-15. PM Derived Universe objects to add to a query for a report on the status
of projects assigned to project managers" on the next page shows the PM Derived Universe objects to
use to create a Project Status by Project Manager report, and where to place them on the NewWeb
Intelligence Document page.
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Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Header All Project Manager

Project Status

Cost Health

Issue Health

Schedule Health

Overall Health

Project Manager / In list / Prompt

Table 3-15. PM Derived Universe objects to add to a query for a report on the status of projects
assigned to project managers

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

The following figure shows example results for the Project Status by Project Manager report.
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Total Scheduled Effort Vs Actual Effort

As a project manager, you can create a report that shows the total scheduled effort (including assigned
and unassigned effort), the actual effort, and the estimated remaining effort for a project for which
you are responsible.

"Table 3-16. PM Derived Universe objects to include in a report that compares scheduled effort, actual
effort, and estimated remaining effort for a project" below lists the PM Derived Universe objects to add
to a Web Intelligence document to create this report in InfoView.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Project Effort Assigned Scheduled Effort

Unassigned Scheduled Effort

Actual Effort

Estimated Remaining Effort

Effort for Current Workplan

Project Header Project Status

Table 3-16. PM Derived Universe objects to include in a report that compares scheduled effort,
actual effort, and estimated remaining effort for a project

Note: For an example of how to add objects to a Web Intelligence document, see the procedure
described in "Ad Hoc Report on Project Management Data: Example" on page 38.

In addition to adding the objects listed in "Table 3-16. PM Derived Universe objects to include in a report
that compares scheduled effort, actual effort, and estimated remaining effort for a project" above to
your report query, this report requires that you create a variable to calculate the total scheduled effort
(sum of assigned scheduled effort and unassigned scheduled effort).

To create the variable for total scheduled effort:
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1. After you add all of the objects to the report query, run the query.

2. In the Reporting toolbar, click Variable Editor ( ).

3. In the Name box, type Total Scheduled Effort.

4. From the Qualification list, select Measure.
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5. In the Formula box, add the following:

=[Assigned Scheduled Effort] + [Unassigned Scheduled Effort]

6. Click OK.

7. In the left pane, click the Data tab.

8. Select the new Total Scheduled Effort object, drag it to the Report tab on the right, and insert it
where you want the Total Scheduled Effort column displayed in the report.

The following figure shows example results for a report that compares scheduled effort, actual effort,
and estimated remaining effort for a project.
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Reporting on Resource Management
l "About this Chapter" below

l "Demand Vs Capacity Report" below

l "Ad Hoc Reports for Resource Management" on page 64

About this Chapter
This chapter addresses Operational Reporting for Resource Management. It provides information about
the preconfigured Demand Vs Capacity report, which HP supplies, and some of the many the ad hoc
reports that you can create for your Resource Management data.

Note: If you organization has multilingual Operational Reporting enabled, make sure that you
configure InfoView to display your operational report data correctly for your locale. For instructions,
see "Using BusinessObjects for Operational Reports" on page 16.

Demand Vs Capacity Report
The Demand Vs Capacity Report that HP supplies with Operational Reporting is designed to help you
review and proactively manage demand to optimize resource use within your organization. This report
enables you to view PPM Center resource capacity (from resource pools, both named and unnamed),
demand (from staffing profiles broken down by committed, soft-booked, and unmet demand), and the
actual effort coming from time sheets. You can use the Demand Vs Capacity report to compare demand
against capacity for different roles by grouping the data by region, resource pool level, or role.

Note: Because capacity is not assigned for a staffing profile or a position, resource capacity is
captured within the context of a resource pool, and not in the context of staffing profile. Capacity
for a resource is assigned by a resource pool manager who may not know how (to what position) a
resource is to be allocated.

The actual effort shown in the Demand Vs Capacity report reflect all of the time that resources have
logged in time sheets, except for time logged on time sheets that have been cancelled. If time logged
against a task is rejected, that actual effort is excluded from the report.
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Note: PPM Center's TM-PM Sync Service rolls up time sheet actuals to projects. Depending on how
often this service is scheduled to run on your PPM Center system, the actual effort displayed in the
Demand Vs Capacity report may not exactly match the staffing profile actuals.

Grouping Report Data

You can group demand, capacity, and effort information presented in the report based on region,
resource pool, or role. Based on the grouping parameter you select (you select only one grouping
parameter at a time), the report displays an aggregate total for each group.

"Table 4-1. Data display in the Demand Vs Capacity report based on grouping" below provides
information about how the Demand Vs Capacity report displays data based on the grouping you select.

Selected Grouping Data Displayed

Role Capacity is displayed at the role level as total. Demand is displayed at the
role level per staffing profile and total for each role level.

If a resource is assigned to a position to meet the demand, then one of the
following is true:

l The resource role (associated with the corresponding capacity) is the
same as the role of the position to which this resource is assigned. In
other words, the capacity role is the same as the demand role.

l The resource role (associated with the corresponding capacity) is
different from the role of the position to which this resource is
assigned. That is, capacity role is not the same as the demand role.

In either case, the Demand Vs Capacity report shows capacity as a function
of the resource's role, and shows demand as a function of the position's
role.

Resource Pool Both capacity and demand are displayed at the role level for each resource
pool. You can view capacity from both named and unnamed resource pools.

Region Both capacity and demand are displayed at the role level for each region.

Resource pool capacity is accounted against the resource pool region and
demand is accounted against the staffing profile position's resource pool
region for both unmet and met demand. One exception to this is that, if
there is unmet demand that is not associated with a resource pool, then
the report accounts for the unmet demand against the staffing profile

Table 4-1. Data display in the Demand Vs Capacity report based on grouping

Operational Reporting User's Guide
Chapter 3: Using BusinessObjects for Operational Reports

HP Project and Portfolio Management Center (Content Pack 2.0, on PPM Center 9.30) Page 57 of 131



Selected Grouping Data Displayed

region.

Note: In an ad hoc Demand Vs Capacity report that includes the query
"show the demand for positions in a staffing profile," all demand is
accounted against the staffing profile region if you select the Demand
from Staffing Profile Region context. For an ad hoc Demand Vs Capacity
report that includes the query "show the capacity of resources in a
resource pool," all of the capacity is accounted against the resource pool
region.

Table 4-1. Data display in the Demand Vs Capacity report based on grouping, continued

How Regional Calendar Affects Demand Vs Capacity Report Data

"Table 4-2. Calendars used to calculate capacity (in hours, person days, and FTEs) for different PPM
Center entities" below lists the calendars that affect how resource capacity is calculated for the
Demand Vs Capacity report.

Calendar Description

A Resource Regional Calendar Calendar associated with the resource's
region.

B Resource Calendar Calendar on the resource detail page,
which is derived from the resource's
regional calendar (A).

C Resource Pool Calendar Calendar associated with the resource
pool through the resource pool's region.

D Staffing Profile Calendar Calendar associated with the staffing
profile via the staffing profile's region.

E Staffing Profile Default Resource Pool Calendar Calendar associated with the staffing
profile's default resource pool.

F Position (Resource Pool) Calendar Calendar associated with the position's
resource pool.

Table 4-2. Calendars used to calculate capacity (in hours, person days, and FTEs) for different PPM
Center entities

The following sections describe how the calendars listed in "Table 4-2. Calendars used to calculate
capacity (in hours, person days, and FTEs) for different PPM Center entities" above affect PPM Center
entities.
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Capacity for Named Resources

When a named resource is added to the resource pool, the available number of hours or days for that
resource comes from the Resource Calendar (B). The FTE is calculated against the Resource Regional
Calendar (A).

Capacity for Unnamed Resources

The available number of hours or person days or FTE is manually entered for unnamed and conversion
to FTE or hours is calculated against the Resource Pool Calendar (C).

Demand

If a staffing profile has a Regional Calendar and no default resource pool, then:

l When a position is created and no resource pool is linked to it, the
demand entered is converted to hours or FTE against the Staffing Profile Calendar (D).

l When a position is created and is linked to a resource pool, the demand entered is converted to
hours or FTE against the position's Resource Pool Calendar (F).

l When a position's assignment is created, the entered met demand values are defaulted from the
Resource Calendar (B) and the hours or FTE is calculated against the resource's Regional Calendar
(A).

l Unmet demand for position is also calculated against position's Resource Pool Calendar (F).

If a staffing profile has a regional calendar and a default resource pool, then:

l The default resource pool for the staffing profile is used just to default this pool on position.
Because the position's resource pool for calculating the demand is considered, it does not matter
whether this was a default pool or an overwritten pool.

Note: Between Demand (position) and Met Demand (assignment), even if the demand is met by
FTE, the number of hours can vary if they use different calendars.

If an assignment is made and then the calendar is changed, the data is not retroactively changed to
reflect the changes in calendars.
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Running the Demand Vs Capacity Report

To run the Demand Vs Capacity Report, do the following:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section or in the header panel of the InfoView home page, click Document List.

Note: The folders and objects visible in the document list vary, depending on the account you
logged on to, the rights that your BusinessObjects Enterprise administrator granted to you,
and the settings that you and your administrator enable.

3. In the Tree panel in the left portion of the page, expand the Public Folders folder, and then select
HP PPM Reports.

4. In the panel to the right, double-click Demand Vs Capacity Report.

The Prompts dialog box lists the prompts that are available for the report query. All prompts for
which values are required have default values, but you can change these values, and specify values
for any or all of the optional prompts listed.

Note: A green check mark ( ) to the left of a listed prompt indicates that the prompt is

required, and that a value has been specified for it. A red arrow ( ) to the left of a listed

prompt indicates that the prompt is required and you must specify a value for it before you
can run the report query.

5. To filter the data further, before you run the report, provide information for the prompts listed
and described in the following table.

Note: If you do not specify a value for a prompt, the filter is not applied to report data.

Prompt

* Value Required Description

*Primary Grouping Determines how data are categorized in the report. Select one of the
following values:
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Prompt

* Value Required Description

o Region

o Resource Pool

o Role

*Begin Period Determines the first time period for which data are displayed in the
report. Select a value from the Available Periods list.

*End Period Determines the last time period for which data are displayed in the
report. Select a value from the Available Periods list.

*Time Granularity Determines the time interval for data displayed in the report. Select one
of the following values:

o Year displays time periods as yyyy

o Half Year displays time periods as h1 or h2/yyyy

o Quarter displays time periods as quarter/yyyy

o Month displays time periods as mm/yyyy

o Week displays time periods as mm/dd/yyyy

Note: If you specify a long report period andWeek as the time
granularity, and you export the generated report data to Microsoft Excel,
the data in the resulting Excel file may be truncated as a result of
formatting limitations. You can only work around this by exporting the
Web intelligence document to a text file, and then opening that file in
Excel. File formatting is lost in this case.

*Time Unit Determines the time unit (FTE, person days, or hours) to use to display
capacity and demand data in the report. Select one of the following
values:

o FTE

o Person Days

o Hours
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Prompt

* Value Required Description

Resource Pool Determines which resource pools are represented in the report. From
the Resource Pool Name list, select one or more resource pools names.

Region Determines the region for which data are displayed in the report. Select
a value from the Region list.

Role Determines the roles represented in the report. Select one or more
values from the Role Name list.

Resource Category InfoView lists all of the resource categories defined for resources in PPM
Center.

From the Resource Category list, select one or more resource categories
to include in the report.

6. From the list in the top section of the dialog box, select a prompt.

7. InfoView lists available values for some prompts in the box in the lower left portion of the dialog
box. If no values are listed for the prompt you select, click Refresh Values to display the values.

8. After you finish specifying optional data filters, click Run Query.

Web Intelligence retrieves the data for the default values and returns the results in the report.

Demand Vs Capacity Report Results

"Table 4-3. Columns displayed in the Demand Vs Capacity Report" below provides descriptions of the
columns displayed in the Demand Vs Capacity Report.

Column Description

Grouping category Reflects the grouping category selected for the report. (See "*Primary
Grouping" on page 60.)

Time Unit Displays the unit (hours, person days, FTEs) used to express capacity, demand,
and effort in the report.

Resource Pool Displays the names of the resource pools represented by the report data and a
No Resource Pool row for demand that is not assigned to any resource pool.

Table 4-3. Columns displayed in the Demand Vs Capacity Report
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Column Description

Role Displays the role(s) within each resource pool for which report data are
displayed. If no filter has been specified for the Role prompt, this column lists
all roles for each resource pool.

Time period Column headings that show the time period for the report data are displayed
from left to right, starting with the first report period and ending with the
report finish period. Time period is formatted based on the value selected for
the "*Time Granularity" on page 61 prompt.

Demand Displays a breakdown of demand for the time period under the following
column subheadings (expressed in the selected for the "*Time Unit" on page 61
prompt) for each role in each resource pool represented in the report (and for
demand unassigned to any resource pool:

l Committed - Displays demand for which resource pool resources are
committed.

l Soft Booked - Displays demand for which resource pool resources are soft-
booked.

l Unmet - Displays unmet demand.

l Total Demand - Displays

Total demand for each of these columns is displayed for each resource pool, as
well as for the demand that is not assigned to any resource pool.

Capacity For each time period, displays a breakdown of capacity (expressed in the units
selected for the "*Time Unit" on page 61 prompt) by role/resource pool for the
following categories:

l Named - Displays capacity for named resources.

l Unnamed - Displays capacity for unnamed resources.

l Total Capacity - Displays total capacity for named and unnamed resources.

Demand Vs
Capacity

For each time period, this column displays the discrepancy, if any, between total
demand and total capacity for each role/resource pool. If demand exceeds
capacity, the value is displayed in red text in parentheses. If capacity equals or
exceeds demand, the value is displayed in black text.

Actual Effort For each time period, displays a breakdown of actual effort (expressed in the
units selected for the "*Time Unit" on page 61 prompt) by role/resource pool.

Table 4-3. Columns displayed in the Demand Vs Capacity Report, continued
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Ad Hoc Reports for Resource Management
This section provides information about the operational reports that you can create for Resource
Management, and includes examples on how to create a few of these reports. It provides information
about the contexts available for the reports, recommendations on creating the ad hoc reports, and
includes guidance on how to use PPM Center universe objects in operational report queries.

Contexts for Ad Hoc Reports for Resource Management

When you create an ad hoc report for Resource Management, InfoViewmay prompt you to select a
context for your report query. A context consists of a set of well-defined joins that create a unique
query path involving multiple dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a common set of dimensions,
the joins between multiple facts and the related dimensions result in a loop. By providing separate
contexts for each fact and the related dimensions, the loop is eliminated, so that you can query multiple
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports you create for Resource
Management data:

l Resource Capacity

Use the "Resource Capacity" context to retrieve capacity information across Resource, Resource
pool, Roles, Org Unit over a fiscal time period. In this context, Region refers to the Resource Pool's
region, Role refers to the resource's primary role and Organization Unit refers to the resource pool's
organization unit

l Resource Demand on Resource Pool Region

Use the "Resource Demand on Resource Pool Region" context to view resource demand (as in the
preconfigured Demand Vs Capacity report) based on region. Demand assigned to a resource pool is
treated as a demand on the resource pool's region. Demand that is not associated with a resource
pool is treated as coming from the staffing profile's region.

In this context, Region refers to the resource pool's region, Role refers to the position's role, and
Organization Unit refers to the staffing profile's Organization Unit.

l Resource Demand from Staffing Pool Region
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Use the "Resource Demand from Staffing Pool Region" context to retrieve resource demand data
across positions, staffing profiles, resource pools, regions, and fiscal periods and to see which region
(associated with the staffing profile) is the source of the demand.

In this context, Region refers to the region associated with a staffing profile, Role refers to the role
assigned to a position, and Organization Unit refers to the organization unit staffing profile belongs
to.

l Resource Effort

Use the "Resource Effort" context to retrieve effort data across various dimensions (for example,
Roles, Resource Pools, Staffing Profiles, Regions, and so on.)

In this context, Region refers to the resource's region, Role refers to the task's role (if the task has
a role) or the resource's primary role, and Organization Unit refers to the primary organization unit
to which the resource is assigned.

l Resource Pool in a region and its Org Unit

Use the "Resource Pool in a region and its Org Unit" context to retrieve the resource pools in a
region and the org units to which resource pools belong.

Best Practices for Reporting on Resource Management Data

This section provides recommendations for getting the best results in the ad hoc operational reports
you create for your Resource Management data.

Grouping Program Measures by Business Objective for Programs with
Multiple Business Objectives

Suppose you want to construct an ad hoc report query that includes program measures (Forecast,
Actuals, Approved, and so on) grouped by business objective, and you want the query results to include
one or more objects from the Business Objectives class (in the FM Derived Universe). If you are reporting
on a program that has multiple business objectives, the resulting data for the measures are multiplied
by the number of associated business objectives. This produces incorrect report data.

To work around this issue, create a report variable that counts the number of separate business
objectives for the program. Use this variable in each ad hoc report cell that displays the program
measure, to divide the cell's total by this value. (The Financial Summary report uses this mechanism.)
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Querying Resource Pool Measures When with Resource Pool Have Multiple
Managers

Suppose you create a query that includes measures such as Capacity or Demand against the Resource
Pool dimension, and your query results include the Resource Pool Manager object. If you are reporting
on a resource pool that has multiple managers, the resulting data for the measures are multiplied by
the number of resource pool managers. This produces incorrect report data.

To work around this issue, create two separate report queries. Design one query to retrieve the
information about the resource pool dimension or any other dimension objects as necessary, without
including any measures. Design a second query to retrieve the measures.

Effects of Modified Calendar Setup on Data Calculation

If you modify the calendar setup, Actual Effort data displayed in FTEs and the Person Days data within
the affected time range are not automatically recalculated unless modifications are also made to the
relevant timesheets.

Querying Projects with More than One Manager

In querying a project based on project manager, exercise caution when creating the filter condition for
the query. If the project has multiple managers assigned to it, make sure that the query returns all
projects managed based on the resource name specified in the filter, whether the resource is the only
manager assigned to the project or one of several managers assigned. When you create a query filter
for the Project Manager object, select the "Matches pattern" operation and add the percent character
(%) at the beginning and at the end of the name selected from the list of project managers.

Displaying Demand, Capacity, and Effort Data in FTEs

Demand, Capacity, Effort cannot be calculated in full time equivalents (FTE) if a given period the system
calendar setup indicates that the total number of working days for the period is zero. For example, if
every day in a given week is configured as a non-working day for a shut-down period, then the demand,
capacity, and effort data for that week is displayed as zero FTEs. However, the value in hours may not
be zero. That would be the case if, for example, a resource worked during the shut-down period. Even if
the calendar indicates that the number of working days is zero, the capacity or effort may not be.

To avoid inaccuracies, if the report results show zero FTEs for demand, capacity, or effort data, check
the values for the same measures in hours. A non-zero value indicates the problem lies in the calendar
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setup, in which case, the data returned in hours is more reliable unit for display. (The preconfigured
Demand Vs Capacity report uses this mechanism to determine whether to display demand, capacity,
and effort data in FTEs, or as "--" when the total number of working days in a period is calculated to be
zero.)

Reporting on Resources if the Resource-Manager Hierarchy has No Top-
Level Manager

In the PPM Center database, if a resource-manager hierarchy exists, but no top-level manager has been
assigned to the hierarchy, then a loop exists. The results for any reports designed to include resources
data excludes all of the resources. To prevent this from occurring, make sure that a top-level manager
is assigned to the resource-manager hierarchy.

Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected query filters that
retrieve a large volume of data, your query may time out and fail to return report results. To prevent
this from occurring, do one or both of the following:

l Modify the universe parameters (on the Controls tab of the Universe Parameters dialog box) to
increase the execution time limit.

l Modify the query filters to retrieve a smaller dataset.

Calculating Resource Over-Allocation

In reporting on over-allocation of a resource, make sure that you include the Staffing Profile Name
object in the query result, and not just the Project Name object. This is especially important if a resource
is assigned to multiple staffing profiles (some of which may be free-standing) or if org unit staffing
profiles and not related to the project. If you add only the Project Name object without including the
Staffing Profile Name object, the results exclude the assignment to the resource for non-project
staffing profiles, and may not accurately reflect over-allocation.

Comparing the Role of a Position and the Role of a Resource Assigned to the
Position

In creating a query that compares the role of a position with the actual role of a resource assigned to
that position, you must do the following:
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l Select the Role Name object (Roles class) for the role of the position

l Select the Primary Role object (Resource class) for the role of the resource

l Select either the "Resource Demand from Staffing Pool Region" on page 64 or "Resource Demand
on Resource Pool Region" on page 64 context.

Creating Ad Hoc Reports for Resource Management

The RM Derived Universe delivered with PPM Center includes classes and objects that enable you to
create your own operational reports for Resource Management data. The following are just some of the
ad hoc reports that you can create for your Resource Management data:

l "Resources Assigned to Projects" on the next page

l "All Resources in a Resource Pool" on page 74

l "Baseline Demand Vs. Active Staffing Profile Demand for a Project" on page 76

l "Demand, Capacity, and Actual Effort Report (Grouped by Primary Organizational Unit)" on page 77

l "Total Demand Vs. Capacity Plus Additional Resource Pool Data" on page 78

l "Resource Pools by Region" on page 79

l "All Resources by Resource Category" on page 80

l "All Assignments to Resource (by Staffing Profile) with Role, Showing All Effort" on page 81

l "Staffing Profile Details for Resources" on page 82

This section includes instructions on how to create one such report and provides descriptions of other
ad hoc reports that you can create for Resource Management.

Creating an Ad Hoc Report on Resource Management Data: Example

A resource pool manager who needs to know how the resources in various resource pools are
distributed across projects can quickly create a report that provides this information. "Table 4-4. RM
Universe objects to include in a report on the resources in PPM Center resource pools" on the next page
shows which RM Universe objects are required to create this report, and where they belong in the New
Web Intelligence Document page.
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Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name / In list / Prompt

Resources Resource Name

Resource Pools Resource Pool Name

Resource Pool Managers

Roles Role Name

Table 4-4. RM Universe objects to include in a report on the resources in PPM Center resource pools

The following example includes the basic steps required to create and run this report query. For detailed
information about creating Web Intelligence documents, see the BusinessObjects Enterprise InfoView
User's Guide.

Resources Assigned to Projects

To create a report that shows the resource pools and resources assigned to projects:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section of the InfoView home page, click Document List.

Note: The folders and objects visible in the Document List depend on the account you logged
on to, the rights that your BusinessObjects Enterprise administrator granted to you, and the
settings that you and your administrator enable.

3. From the New list, select Web Intelligence Document.
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4. From the list of available universes, select RM Derived Universe.

5. A Warning - Security dialog box opens to advise you of a security concern related to Java
application components and to allow you to block potentially unsafe components. Click No.

The Data tab in the left pane lists all of the available classes and objects in the RM Derived
Universe.

6. Expand the Project Information class folder.
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7. Drag the Project Name object to the Result Objects section on the right (top), and then drag the
Project Name object to the Query Filters section on the right (bottom).

8. In the Query Filters panel, click the list button ( ) at the right end of the Project Name box, and

then select Prompt.
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9. In the Query Filters panel, click the Prompt Properties button ( ).

10. In the Prompt Properties section of the Prompt dialog box, select the Select only from list and
Optional prompt check boxes.

11. Click OK.

12. Expand the Resource Pools class folder, and then drag the Resource Pool Name and Resource
Pool Managers objects to the Result Objects section.

13. Expand the Resources class folder, and then drag the Resource Name object to the Result Objects
section.
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14. Expand the Roles class folder, and then drag the Role Name object to the Result Objects section.

15. Click Run Query.

The Query Contexts dialog box opens.
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16. If, as in this case, the set of objects you select to construct your ad hoc report query can be
retrieved through multiple join paths, InfoView prompts you to select a context for the query. (A
context defines a join path.) Select the Resource demand on resource pool region context, and
then click OK.

Note: To see how a context in the list affects report results, click the context name and read
the content displayed in the Description box.

The Prompts dialog box opens.

17. Specify the projects to include in the report, and then click Run Query.

InfoView runs the report, which lists the resources and the resource pools assigned to the project.

18. Provide a title for the report.

19. Name and save the document.

All Resources in a Resource Pool

You can create a simple report that lists all of the resources assigned to a resource pool. "Table 4-5. RM
Universe objects to include in a report that lists all resources in a resource pool" below lists the RM
Universe objects required to create this report, and shows where they belong in the NewWeb
Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Resources Resource Name

Resource Pools Resource Pool Name Resource Pool Name

Table 4-5. RM Universe objects to include in a report that lists all resources in a resource pool
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In this case, the set of objects you select to construct your ad hoc report query can be retrieved through
multiple join paths, when you run the query, InfoView prompts you to select a context for the query.

Select the Resource demand on resource pool region context.

A resource assigned to a resource pool is only included in this report if the following are true:

l The resource has capacity data. When you run the query for this report, you must select a context to
use with the query. Apply the "Resource capacity" context to the report query.

Note: Within the resource capacity query context, the report displays resource capacity data
across resource pools, regions, roles, organization units, and fiscal time periods. The resource
capacity context enables you to view data from a resource pool manager's perspective.

l The start date for the resource (Resources Start Date) and (or) the end date for the resource
(Resources End Date) falls between the start and end dates of the Resource Management data
loaded into the reporting schema.
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Baseline Demand Vs. Active Staffing Profile Demand for a Project

You can create a report that enables you to compare active staffing profiles with baseline staffing
profiles for specific projects. "Table 4-6. RM Universe objects for a report used to compare the baseline
demand and active staffing profile demand for a project" below lists the RM Universe objects that you
to add to a Web intelligence document to create this report.

Object Class Result Objects Query Filters / Operator / Filter Type

Project Information Project Name Project Name

Staffing Profiles Staffing Profile
Name

Baseline Staffing Profile

Staffing Profile Name

Staffing Profiles > Positions
(subclass)

Position Name

Fiscal Periods Quarter Period
Name

Date Range / Begin Period, End Period, Time
Granularity

Resource Demand > Demand
(FTE)

Committed Demand
(FTE)

Softbooked Demand
(FTE)

Unmet Demand
(FTE)

All Demand (FTE)

Table 4-6. RM Universe objects for a report used to compare the baseline demand and active
staffing profile demand for a project

Set the query filters as shown in "Figure 4-1. Query filters for the ad hoc report Baseline Demand Vs.
Active Staffing Profile Demand for a Project" on the next page.
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Figure 4-1. Query filters for the ad hoc report Baseline Demand Vs. Active Staffing Profile Demand
for a Project

"Creating an Ad Hoc Report on Resource Management Data: Example" on page 68 provides an example
of how to add these objects to the Web Intelligence document in InfoView.

Caution: If your fiscal year begins in a month other than January, and your report query specifies a
time granularity of quarters, half years, or years, then make sure that the Begin Period month
begins on the fiscal quarter, half year, or year, respectively. Otherwise invalid results are returned.

Demand, Capacity, and Actual Effort Report (Grouped by Primary
Organizational Unit)

You can create a report that shows demand, capacity, and actual effort data for resources grouped by
the primary organizational unit to which the resources belong. "Table 4-7. RM Universe objects for a
report used to show that shows demand, capacity, and actual effort data for resources grouped by
primary organizational unit" on the next page lists the RM Universe objects to use to create this report.
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Object Class Result Objects
Query Filters / Operator / Filter
Type

Resources Primary
Organization Unit

Primary Organization Unit / Prompt

Fiscal Periods Month Period Name Date Range

Resource Pools Resource Pool Name

Staffing Profiles Staffing Profile
Name

Roles Role Name

Resource Capacity > Capacity (Hours)
subclass

All Capacity (Hours)

Resource Demand Exclude Demand from Baseline
Staffing Profile

Exclude Obsolete Demand from
Proposal

Resource Demand > Demand (Hours)
subclass

All Demand (Hours)

Resource Effort Effort (Hours)

Table 4-7. RM Universe objects for a report used to show that shows demand, capacity, and actual
effort data for resources grouped by primary organizational unit

Note: If you select specific primary organization units in the filter condition, unnamed capacity data
are excluded from the results since unnamed resources do not belong to any organization units. If
you do not select any specific primary organization units in filter condition, the report includes any
unnamed capacity.

For an example of how to add the objects to the Web Intelligence document, see the procedure
described in "Creating an Ad Hoc Report on Resource Management Data: Example" on page 68.

Total Demand Vs. Capacity Plus Additional Resource Pool Data

A resource pool manager can create a report that shows a comparison of demand and capacity for a
resource pool with detailed resource pool information. "Table 4-8. RM Universe objects to include in a
report on demand, capacity, and actual effort, with data grouped by primary organizational unit" on the
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next page lists the RM universe objects to use to create this report, and where to place them on the
NewWeb Intelligence Document page.

Object Class Result Objects
Query Filters / Operator / Filter
Type

Resource Pools Resource Pool Name

Resource Pool Managers

Parent Resource Pool

Parent Resource Pool
Name1

Resource Pool Name

Fiscal Periods Year Period Name Date Range

Roles Role Name

Resources Resource Name

Resource Capacity > Capacity
(FTE)

All Capacity (FTE)

Named Capacity (FTE)

Unnamed Capacity (FTE)

Resource Demand > Demand
(FTE)

All Demand (FTE)

Unmet Demand (FTE)

Committed Demand (FTE)

Softbooked Demand (FTE)

Table 4-8. RM Universe objects to include in a report on demand, capacity, and actual effort, with
data grouped by primary organizational unit

For an example of how to add the objects to the Web Intelligence document, see the procedure
described in "Creating an Ad Hoc Report on Resource Management Data: Example" on page 68.

Resource Pools by Region

You can create a report that enables users to see which resource pools are associated with which
regions. "Table 4-9. RM Universe objects to include in a report on resource pools grouped by region" on
the next page lists the RM Derived Universe objects to use to create this report, and where to place
them in InfoView.
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Object Class Result Objects Query Filters / Operator / Filter Type

Resource Pools Resource Pool Name

Resource Pool Managers

Regions Region Name Region Name / In list / Prompt

Roles Role Name

Table 4-9. RM Universe objects to include in a report on resource pools grouped by region

A resource assigned to a resource pool is only included in this report if the resource has capacity data.
When you run the query, InfoView prompts you to select a context for the query.

Select the Resource capacity context.

All Resources by Resource Category

You can create a report that lists the resource pools and resources used to staff your projects. "Table
4-10. RM Universe objects to include in a report on which resources in which resource categories are
assigned to PPM Center projects" on the next page lists the RM universe objects to use to create this
report, and where to place them in InfoView.
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Object Class Result Objects Query Filters / Operator / Filter Type

Resources Resource Category

Primary Organization Unit

Resource Name

Primary Role

Resource Category / Prompt

Resource Pool Name Resource Pools

Table 4-10. RM Universe objects to include in a report on which resources in which resource
categories are assigned to PPM Center projects

When you run this report query, InfoView prompts you to select a context for the report. Select
Resource capacity.

For an example of how to create and run an ad hoc report for Resource Management, see "Creating an
Ad Hoc Report on Resource Management Data: Example" on page 68.

All Assignments to Resource (by Staffing Profile) with Role, Showing All
Effort

You can create a report that shows the resources (and roles) assigned to staffing profiles, the effort
that these resources have logged, and the demand that each of the staffing profiles requested of the
resources. A resource manager or project manager can use this report to compare the actual effort a
resource has made with what a staffing profile originally requested. "Table 4-11. RM Universe objects to
include in a report on which resources are assigned to which staffing profiles and the effort the
resources have logged" below lists the RM Universe objects required to create this report, and shows
where they belong in the NewWeb Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Staffing Profiles Staffing Profile
Name

Resources Resource Name

User Name

Resource Demand Exclude Obsolete Demand from
Proposal

Table 4-11. RM Universe objects to include in a report on which resources are assigned to which
staffing profiles and the effort the resources have logged
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Object Class Result Objects Query Filters / Operator / Filter Type

Resource Demand > Demand
(Hours)

All Demand (Hours)

Resource Effort Effort (Hours)

Fiscal Periods <Period> Name Date Range

Roles Role Name

Project Information Project Name

Request Information Source Entity Type

Request ID

Table 4-11. RM Universe objects to include in a report on which resources are assigned to which
staffing profiles and the effort the resources have logged, continued

You can tailor this report to show only the actual effort that resources have logged. If you do, however,
keep in mind that if your query does not contain demand information, then the report results exclude
resources who have not logged time during the time period you specify for the query. This means that
you cannot see all of the resources assigned to the staffing profile.

Note: Actual effort can be associated with the staffing profile level only if time is logged against a
project or a Portfolio Management request (which is associated with staffing profiles), but not to
the position level. This means that when you perform an ad hoc query, you can associate actual
effort with staffing profile attributes only, and not positions attributes.

Staffing Profile Details for Resources

You can create a report that displays staffing profile details for resources. This report would list
resources along with their start and end dates, role requested, org unit, resource pool, manager, and
the primary role each resource assumes in the organization. "Table 4-12. RM Universe objects to include
in a report on which resources in which resource pools are assigned to a PPM Center project" below lists
the RM universe objects to use to create this report, and where to place them on the NewWeb
Intelligence Document page.

Object Class Result Objects Query Filters / Operator / Filter Type

Staffing Profiles Staffing Profile Name Staffing Profile Name / Prompt

Table 4-12. RM Universe objects to include in a report on which resources in which resource pools
are assigned to a PPM Center project
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Object Class Result Objects Query Filters / Operator / Filter Type

Start Date

Finish Date

Roles Role Name

Resources Primary Organization Unit

Manager Name

Resource Name

Resource Pools Resource Pool Name

Table 4-12. RM Universe objects to include in a report on which resources in which resource pools
are assigned to a PPM Center project, continued

When you run this report query, you are prompted to select a context for the report. Select Resource
demand on resource pool region for this report.

For information about how to add the objects to a newWeb Intelligence document, see the procedure
described in "Creating an Ad Hoc Report on Resource Management Data: Example" on page 68.

Reporting on HP Time Management
This chapter addresses Operational Reporting for HP Time Management. It provides information about
the preconfigured Time Sheet Compliance report that HP supplies and some of the many ad hoc reports
that you can create for your HP Time Management data.

Time Sheet Compliance Report
HP provides the Time Sheet Compliance report for HP Time Management with the Operational Reporting
solution. This report enables you to continuously monitor time entry compliance across your entire
organization and to identify organizational units and resources that are out of compliance. You can
monitor time compliance company-wide, without having to delve into tedious details. Summarized data
provide an overview of time compliance within the context of management chains, organizational units,
or resource pools.

The Time Sheet Compliance report displays the total number of time sheets logged, submitted (or not),
approved on time (or not), as well as trends in compliance over specified time periods. If you need
additional information, you can use drill-down functionality to see the details of time compliance at
each level of the management chain, organization unit and resource pool.
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This section provides information about the required and optional prompts for the Time Sheet
Compliance report query, and descriptions of the displayed report results.

Note: For information about how to create newWeb Intelligence report documents to report on
your HP Time Management data, see "Ad Hoc Reports for HP Time Management" on page 91.

Time Sheet Compliance Report Query Information

"Figure 5-1. Prompt dialog box for the Time Sheet Compliance Report" below shows the Prompt dialog
box for the Time Sheet Compliance Report. "Table 5-1. Prompts for the Time Sheet Compliance Report
query" on the next page lists descriptions of the information to provide for the query.

Figure 5-1. Prompt dialog box for the Time Sheet Compliance Report
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Prompt

* Value Required Description

*Period Range Beginning Date Determines the start date of the date interval for data
displayed in the report.

If the end date of a period falls between the period range
beginning and end dates, then data for that the period are
included in the report.

*Period Range Ending Date Determines the end date of the date interval for data
displayed in the report.

If the end date of a period falls between the period range
beginning and ending dates, then data for that the period are
included in the report.

*Time Sheet Line Status(es) Determines whether the report displays data for all time
sheet lines, regardless of line status, or only for time sheet
lines that have a specific status.

Select one of the following values:

l * (default)

l Unsubmitted

l Submitted

l Approved

l Rejected

l Frozen

l Closed

*Time Sheet Status(es) Determines whether the report displays data for all time
sheets, regardless of line status, or only for time sheets that
have a specific status.

Select one of the following values:

l * (default)

l Unsubmitted

Table 5-1. Prompts for the Time Sheet Compliance Report query
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Prompt

* Value Required Description

l Pending Approval

l In Rework

l Approved

l Frozen

l Closed

l Missing

Note: Although "Missing" is not a valid status for PPM Center
time sheets, in operational reports, it represents time sheets
that have no assigned status.

* Tolerance for Approval (days) Number of days after the period end date after which the time
sheet cannot be approved as compliant.

* Tolerance for Submission (days) Number of days after the period end date after which the time
sheet cannot be submitted as compliant.

* Top Org Unit Filter report data based on a selected organizational unit. The
report returns all of the data that fall below the organizational
unit in the hierarchy.

Request Type Name(s) (Optional) Filters report data based on one or more selected
request types.

Project Name(s) (Optional) Filters report data based on one or more selected
projects.

Location Code(s) (Optional) Filter report data based on one or more selected
locations.

Resource Category(s) (Optional) Filter report data based on one or more selected
resource categories.

Department(s) (Optional) Filter report data based on one or more selected
departments.

Company(s) (Optional) Filter report data based on one or more selected
companies.

Table 5-1. Prompts for the Time Sheet Compliance Report query, continued
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Prompt

* Value Required Description

Charge Code(s) (Optional) Filter report data based on a selected charge code.

Table 5-1. Prompts for the Time Sheet Compliance Report query, continued

Caution: The Time Sheet Compliance report includes timesheets for the resource pool to which a
resource currently belongs. This is true even if the timesheets are for a future or past time period
and the resource is associated with a different resource pool for that time period.

Time Sheet Compliance Report Results

The following sections provide descriptions of the Time Sheet Compliance Report results as they appear
on the different report tabs.

Note: If, in the past, you purged time-sheet data from the audit events table in an effort to
improve performance, that data is no longer available for reporting and is not included in the Time
Sheet Compliance Report results.

Direct Manager Tab

The Direct Manager tab shows submission and approval compliance data grouped bymanager
hierarchy and resource category. The manager hierarchy in the report is shown from the top, up to
three levels deep. The query used to generate the report includes up to ten hierarchy levels. This can be
useful in data filtering.

"Table 5-2. Columns on the Direct Manager tab of the Time Sheet Compliance Report" below lists
descriptions of the columns displayed on the Direct Manager tab of the Time Sheet Compliance Report.

Column Heading Description

Manager Hierarchy - Level 1 Top-level manager in the management hierarchy

Manager Hierarchy - Level 2 Second-level manager from the top in the
management hierarchy

Manager Hierarchy - Level 3 Third-level manager from the top in the management
hierarchy

Table 5-2. Columns on the Direct Manager tab of the Time Sheet Compliance Report
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Column Heading Description

Resource - Direct Manager Direct manager or the lowest-level manager for the
resource.

Resource - Category Category to which the resource belongs

Time Sheet Compliance - Expected Total
Time Sheets

Number of time sheets that must be submitted for
compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant Total number of compliant time sheets submitted

Submissions - % Compliance Total percentage of submitted time sheets that are
compliant

Approvals - Total Total number of submitted time sheets that were
approved

Approvals - Compliant Total number of time sheets that were compliant for
approval

Approvals - % Compliance Approval compliance percentage

Table 5-2. Columns on the Direct Manager tab of the Time Sheet Compliance Report, continued

To see detailed information about a specific resource manager, click the hyperlinked name for the
manager. The Resource Information Report opens in a new web browser window and displays the
manager's name, department, location, category, company, role name, and direct manager.

Org Unit Tab

The Org Unit tab displays submission and approval compliance data grouped based on the org unit
hierarchy and the resource category. The org unit hierarchy in the report is shown from the top up to
three levels deep. The query used to generate the report includes up to ten hierarchy levels, which can
be useful in filtering data.

"Table 5-3. Columns on the Org Unit tab of the Time sheet Compliance Report" below lists descriptions
of the columns displayed on the Org Unit tab of the Time Sheet Compliance Report.

Column Heading Description

Org Unit Hierarchy - Level 1 Top org unit in the org unit hierarchy

Table 5-3. Columns on the Org Unit tab of the Time sheet Compliance Report
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Column Heading Description

Org Unit Hierarchy - Level 2 Second org unit from the top of the org unit hierarchy

Org Unit Hierarchy - Level 3 Third org unit from the top of the org unit hierarchy

Resource - Direct Manager Direct, or lowest-level manager for the resource

Resource - Category Category to which the resource belongs

Time Sheet Compliance - Expected Total
Time Sheets

Number of time sheets that must be submitted for
compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant Total number of submitted time sheets that were
compliant

Submissions - % Compliance Submission compliance percentage

Approvals - Total Total number of time sheets that were approved

Approvals - Compliant Total number of time sheets that were compliant for
approval

Approvals - % Compliance Approval compliance percentage

Table 5-3. Columns on the Org Unit tab of the Time sheet Compliance Report, continued

The Org Unit tab shows group totals for the org unit and for three levels of org units, starting at the top
of the management hierarchy. To see detailed information about a specific org unit, click the
hyperlinked name of the org unit. The Organization Unit Information Report opens in a new web browser
window and displays the org unit's name, department, location, category, and the org unit manager's ID.
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Resource Pool Tab

The Resource Pool tab displays submission and approval compliance data grouped based on the
resource pool hierarchy. The resource pool hierarchy in the report is shown from the top to three levels
deep. The query used to generate the report includes up to ten hierarchy levels, which can be useful in
filtering data.

"Table 5-4. Columns on the Resource Pool tab of the Time Sheet Compliance Report" below lists
descriptions of the columns displayed on the Resource Pool tab of the Time Sheet Compliance Report.

Column Heading Description

Resource Pool Hierarchy - Level 1 Top resource pool in the resource pool hierarchy

Resource Pool Hierarchy - Level 2 Second resource pool from the top of the resource
pool hierarchy

Resource Pool Hierarchy - Level 3 Third resource pool from the top of the resource pool
hierarchy

Resource - Resource Pool Resource pool to which the resource belongs

Resource - Category Category to which the resource belongs

Time Sheet Compliance - Expected Total
Time Sheets

Number of time sheets that must be submitted for
compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant Total number of submitted time sheets that were
compliant

Submissions - % Compliance Submission compliance percentageWhat does this
mean?

Approvals - Total Total number of time sheets that were approved

Approvals - Compliant Total number of time sheets that were compliant for
approval

Approvals - % Compliance Approval compliance percentageWhat does this mean?

Table 5-4. Columns on the Resource Pool tab of the Time Sheet Compliance Report

To see a report that contains additional details about the manager of the resource, click the
hyperlinked manager name. The Resource Information Report opens in a new browser window and
displays the manager's name, resource category, location, department, company, direct manager, role
and email address.
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The time sheets for resources who participate in multiple resource pools are counted against each
resource pool.

Caution: The Time Sheet Compliance report includes time sheets for the resource pool to which a
resource currently belongs. This is true even if the time sheets are for a future or past time period
and the resource is associated with a different resource pool for that time period. As a result, the
Time Sheet Compliance Report may exclude some resource pools. For example, if a resource was
assigned to a different resource pool in the past, that resource pool is not included in the Time
Sheet Compliance Report.

Ad Hoc Reports for HP Time Management
The following sections provide information about the operational reports that you can create for HP
Time Management, and includes examples on how to create a few of these reports. These sections also
provides information about the contexts available for the reports, and includes guidance on how to use
PPM Center universe objects in operational report queries.

Contexts for Ad Hoc Reports for HP Time Management

When you create an ad hoc report for Resource Management, InfoViewmay prompt you to select a
context for your report query. A context consists of a set of well-defined joins that create a unique
query path involving multiple dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a common set of dimensions,
the joins between multiple facts and the related dimensions result in a loop. By providing separate
contexts for each fact and the related dimensions, the loop is eliminated, so that you can query multiple
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports you create for HP Time
Management data:

l Time Sheet Compliance context

The "Time Sheet Compliance" context enables you to query for compliance measures such as
Required Time Sheets, Compliant Submissions, Compliant Approvals, Total Submissions, Total
Approvals, Submission Percent, and Approval Percent. In this context, the resource pool is joined
through the resource table for compliance measures.
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Note: The resource pool is joined through the resource table for compliance measures because
no actuals exist for missing time sheets. To get the right compliance measures for the resource
pools, the join with resource table is used.

l Time Sheet Actuals context

The Time Sheet Actuals context enables you to query actuals measures such as Total Effort and
Total Cost. In this context, the resource pool is directly joined with the actuals fact table for the Time
Sheet actuals.

Best Practices for Reporting on HP Time Management Data

This section provides recommendations for getting the best results in the ad hoc operational reports
you create for your HP Time Management data.

Reporting on Multiple Work Item Types

If you generate a report that includes a work item type object (such as Project, Request, or
Miscellaneous object) from the Time Sheet Lines class, the report results includes only the numbers for
that specific work item type. If you generate a report that includes more than one specific work item
type object, no data are returned. For example, if you create and run a report that contains both the
Project object and the Request object, no data are returned because no time-sheet line logs time
against both types of work items. To see the results for different work item types, you must use the
Work Item Type and Work Item Type Name objects instead of the individual objects such as Project,
Request, or Miscellaneous.

Avoiding Inaccurate Data Display Resulting from Summing of Measures

Measures in TM Derived Universe are defined at a time-sheet level. This means that if you create a
report that shows data from the time-sheet line level, and you then remove the time-sheet line
attributes from the report display (but not from the report query), the BusinessObjects sums (collapses)
the measures.

The summing of measures results in inaccurate reports and the data displayed are different than the
data specified in the query. In such cases, when you build the report, remove attributes that are not
needed for the display from the column selections so that the query does not use them.
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Reporting on Compliance Measures

You cannot report on the compliance measures for fiscal periods. Compliance measures are only
supported with HP Time Management periods.

Roles and Regions

Neither roles nor regions are supported for any measures in HP Time Management.

Aggregate Values and Percentages

Because percentages cannot be aggregated, the aggregation function is not applied to the Submission
Percent and Approval Percent measures. If you include the Submission Percent and Approval Percent
objects in a query, BusinessObjects does not aggregate the values at higher levels in the report. For
example, if you query for Organization, Manager, and Submission Percent, you do not see the aggregate
compliance percentage at the organization level. If you want to see aggregate values at different levels,
you must use the Compliant Submissions and Required Timesheets objects and compute the
percentage in the report. (See the HP-supplied Time Sheet Compliance report for this usage.)

Using Filters to Limit Report Output

Because BusinessObjects analyzes only a fixed number of rows (the default is 5000), make sure that you
including appropriate filters to limit report output.

Comparing the Role of a Position and the Role of a Resource Assigned to the
Position

In creating a query that compares the role of a position with the actual role of a resource assigned to
that position, you must do the following:

l Select the Role Name object (Roles class) for the role of the position

l Select the Primary Role object (Resources class) for the role of the resource

l Select either the "Resource Demand from Staffing Pool Region" context or the "Resource Demand
on Resource Pool Region" context.
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Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected query filters that
retrieve a large volume of data, your query may time out and fail to return report results. To prevent
this from occurring, do one or both of the following:

l Modify the universe parameters (on the Controls tab of the Universe Parameters dialog box) to
increase the execution time limit.

l Modify the query filters to retrieve a smaller dataset.

Creating Ad Hoc Reports for HP Time Management

The TM Derived Universe delivered with PPM Center includes classes and objects that enable you to
create your own operational reports for HP Time Management data. The following are just some of the
ad hoc reports that you can create for your HP Time Management data:

l "Delinquent Time Sheets" on the next page

l "Trends in Late Time-Sheet Submission" on page 100

l "Trends in Time-Sheet Processing" on page 101

l "Tracking Billable Time Logged for a Project" on page 102

l "Resources' Work in Progress" on page 102

Note: If, in the past, you purged time-sheet data from the audit events table in an effort to
improve performance, that data is no longer available for reporting and is not included in the ad
hoc reports for HP Time Management data.

Example Ad Hoc Report for HP Time Management Data

This section provides detailed instructions for creating a query for a report on HP Time Management
data.
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Delinquent Time Sheets

A product manager who needs to know who is not submitting their time sheets can create a report that
enables her to see which resources, working for which project managers, have not submitted a time
sheet for a given time period. This simple, tabular report shows the number of late submissions by
period, for a given time range. Data are grouped based on the name of the manager for the resources.

Note: The following example includes very basic steps required to create and run this report query.
For detailed information about creating Web Intelligence documents, see the BusinessObjects
Enterprise InfoView User's Guide.

To create a report that shows which resources have not yet logged a time sheet for the current period:

1. Log on to InfoView.

2. In the Navigate section of the InfoView home page, click Document List.

3. From the New menu, select Web Intelligence Document.

4. From the list of available universes, select TM Derived Universe.
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5. A Warning - Security dialog box opens to advise you of a security concern related to Java
application components and to allow you to block potentially unsafe components. Click No.

The Data tab in the left pane lists all of the available classes and objects in the TM Derived
Universe.

Note: The folders and objects visible in the document list depend on the account you logged
on to, the rights that your BusinessObjects Enterprise administrator granted to you, and the
settings that you and your administrator enable.

6. Expand the Resources class folder.

7. Drag the Resource Name object from the Resources class folder to the Result Objects panel on
the right (top).
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8. Drag the Manager Name object from the Resources class folder to the Query Filters panel on the
right (bottom).

9. In the Query Filters panel, click the list button in the Manager Name box (right end), and select
Prompt from the list.
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10. On the Data tab (left panel), expand the Time Sheets class folder.

11. Drag the Time Sheet Status object from the Time Sheet class folder to the Query Filters panel.

12. In the Time Sheet Status box in the Query Filters panel, click the list button, and then select
Prompt.

13. On the Data tab, expand the Time Management Periods folder.

14. Drag the Time Management Period Name object from the Time Management Periods class folder
to the Result Objects panel.

15. Drag the WhichPeriod Date Range? object from the Time Management Periods class folder to the
Query Filters panel.

16. At the top right of the NewWeb Intelligence Document page, click Run Query.
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The Prompts dialog box opens.

17. To specify the date range for the report:

a. Click Period Range Beginning Date, and then use the Select a custom date multiselect
control to select the beginning date for report data.

b. Click Period Range Ending Date, and then use the Select a custom date multiselect control to
select the end date for report data.

18. To select the names of one or more managers:

a. Click Enter value(s) for Manager Name.

b. In the Manager Name list, select the name of one or more managers, and then click the right-
pointing arrow to add the selection to the box on the right.

19. Click Enter value(s) for Time Sheet Status, and then from the list of time sheet statuses, select
the following values:
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o Unsubmitted

o In Rework

20. At the bottom of the Prompts dialog box, click Run Query.

InfoView runs the report, which lists the resource names and the period names for which the
resources have not submitted time sheets.

21. On the report results page, double-click Report Title, type a name for the report in the now
enabled text box, and then press enter.

22. On the toolbar, click Save .

23. Name and save the document.

Additional Ad Hoc Reports for HP Time Management Data

The following sections describe additional queries that you can construct to create operational reports
for HP Time Management.

Trends in Late Time-Sheet Submission

You can create a report that enables you to uncover trends in late time-sheet submissions based on
who manages the resources, and the teams, organizational units, or departments to which the
resources belong. "Table 5-5. TM Derived Universe objects to include in a report on trends in late time-
sheet submission" below shows the TM Derived universe objects to use for this report, where to place
them in InfoView, and how to set the query filters.

Object Class Result Objects Query Filters / Operator / Filter Type

Compliance Measures l Compliant Submission

l Submission Percent

l Total Submissions

Resources l User Name

l Manager Name

l Manager Name / equal to

l Primary Organization Unit / equal to

Table 5-5. TM Derived Universe objects to include in a report on trends in late time-sheet
submission
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Object Class Result Objects Query Filters / Operator / Filter Type

l Primary Organization
Unit

l Department

l Department / equal to

Time Management Periods Which Period Date Range? Which Period Date Range?

Table 5-5. TM Derived Universe objects to include in a report on trends in late time-sheet sub-
mission, continued

For an example of how to add objects to a newWeb Intelligence document, see "Example Ad Hoc Report
for HP Time Management Data" on page 94.

After you create the Web Intelligence document, run the report and then verify the results. You can
augment this report with additional information such as actuals and time periods data. You can also
experiment with different ways of displaying results by grouping data based on resource name,
department, manager, or organization units. Once the report contains all of the data you want and is
organized the way you want it, you can save the report in Excel or PDF format.

Trends in Time-Sheet Processing

If you are a PPM Center project manager responsible for HP Time Management, you can create a report
that enables you to detect trends in time-sheet processing. You can configure this report to show
differences between the following:

l Time-sheet submissions and time-sheet approval, based on group.

l End of the reporting period and time-sheet approval, based on group.

l Time-sheet rework and time-sheet approval, based on group.

l End of the reporting period and close of the reporting period, based on group.

You can also create a report on time-sheet rejection rate that shows the number of time sheets
rejected (time sheets that required re-work), the resources whose time sheets were rejected multiple
times, and so on, based on group.

For an example of how to add TM Derived Universe objects to a newWeb Intelligence document, see
"Example Ad Hoc Report for HP Time Management Data" on page 94.
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Tracking Billable Time Logged for a Project

If you are a project manager concerned who needs to monitor the billable time your consultants log, you
can create a report that shows billable time logged for a project during a given period, and includes
activity codes and charge codes."Table 5-6. TM Derived Universe objects to include in a report on billable
time" below shows the TM Derived universe objects to use for this report, where to place them in
InfoView, and how to set the query filters.

Object Class Result Objects
Query Filters / Operator / Filter
Type

Time Sheet Lines Item Name

Item Set Name

Resources User Name

Manager Name

Manager Name / Equal to

Time Management
Periods

Time Management Period
Name

Which Period Date Range?

Time Sheet Actuals Total Effort (Hrs)

Table 5-6. TM Derived Universe objects to include in a report on billable time

The resulting report shows all of the work items for which your resources have logged time and actual
effort.

For an example of how to add TM Derived Universe objects to a newWeb Intelligence document, see
"Example Ad Hoc Report for HP Time Management Data" on page 94.

Resources' Work in Progress

If you are a resources manager who needs to know what each of your direct reports is working on, you
can create a report that shows you what your resources have been involved in (projects, requests,
vacation, and so on) over a specified time period. "Table 5-7. TM Derived Universe objects to include in a
report on resources’ work in progress" on the next page shows the TM Derived universe objects to use
for this report, where to place them in InfoView, and how to set the query filters.
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Object Class Result Objects
Query Filters / Operator / Filter
Type

Time Sheet Lines l Item Name

l Item Set Name

Resources l User Name

l Manager Name

Manager Name / Equal to

Time Management
Periods

Time Management Period
Name

Which Period Date Range?

Time Sheet Actuals Total Effort (Hrs)

Table 5-7. TM Derived Universe objects to include in a report on resources’ work in progress

The resulting report displays all work items for which your resources have logged time and actual
effort. You can include additional information such as request types, packages and so on, in your report
query.
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Issues to Consider in Creating Queries for HP Time Management
Reports

This section addresses issues to keep in mind as you construct queries with operational reports on HP
Time Management data. It includes multiple references to objects in the TM Derived Universe of classes
and objects used for reporting on HP Time Management.

Reporting on Financial Management
l "About this Chapter" below

l "Financial Summary Report" below

l "Ad Hoc Reports for Financial Management" on page 108

About this Chapter
This chapter addresses Operational Reporting for Resource Management. It provides information about
the preconfigured Financial Summary report, which HP supplies, and some of the many ad hoc reports
that you can create for your Financial Management data.

Note: If you organization has multilingual Operational Reporting enabled, make sure that you
configure InfoView to display your operational report data correctly for your locale. For instructions,
see "Using BusinessObjects for Operational Reports" on page 16.

Financial Summary Report
You can use the Financial Summary report that HP supplies with Operational Reporting to monitor
ongoing efforts and to generate information that you can use for financial forecasting. PPM Center
provides portfolio scenarios that can help Finance Managers project future scenarios that can be
directly compared against each other and the ongoing efforts using the Financial Management report.

The HP PPM Financial Summary Report enables you to view a comparison of the planned values with the
actual values for a budget, along with all of the budget-related attributes. You can group budget
information based on region, business objective, or budget type (the entity for which the budget was
created).
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Budget values can be analyzed based on expense type or labor type. Budgets costs can be viewed in the
defined local currency of the PPM Center system or any other currency based on the filter criteria.

Running the Financial Summary Report

To run the Financial Summary Report, do the following:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section or in the header panel of the InfoView home page, click Document List.

Note: The folders and objects visible in the document list vary, depending on the account you
logged on to, the rights that your BusinessObjects Enterprise administrator granted to you,
and the settings that you and your administrator enable.

3. In the Tree panel in the left portion of the page, expand the Public Folders folder, and then select
HP PPM Reports.

4. In the panel to the right, double-click Financial Summary Report.

The Prompts dialog box lists the prompts that are available for the report query. All prompts for
which values are required have default values, but you can change these values, and specify values
for any or all of the optional prompts listed.

Note: A green check mark ( ) to the left of a listed prompt indicates that a value has been

specified for the prompt. A red arrow ( ) to the left of a listed prompt indicates that the
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prompt is required and you must specify a value for it before you can run the report query.

5. To filter the data further, before you run the report, provide information for the prompts listed
and described in the following table.

Note: If you do not specify a value for a prompt, the filter is not applied to report data.

Prompt

* Required Description

*Begin Period From the list of all fiscal periods configured for PPM Center,
select the starting period for data to include in the report.

*End Period From the list of all fiscal periods configured for PPM Center,
select the end period for data to include in the report.

*Multiply Factor From the listed factors, select one of the following:

o 1

o 1,000

o 1,000,000

*Primary Group By Determines the primary grouping for data in the report. Select
one of the following values:

o Region

o Financial Summary Type

o Business Unit

o Business Objective

*Report Currency From the list, select one of the following to determine base the
currency associated with financial summary on the default
currency for PPM Center (base) or the local currency.

o Base

o Local
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Prompt

* Required Description

*Secondary Group By Determines the secondary grouping category for data in the
report. Select one of the following values:

o Expense Type

o Labor Type

*Time Granularity Determines the time interval for data displayed in the report.
Select one of the following values:

o Year displays time periods as yyyy

o Half Year displays time periods as h1 or h2/yyyy

o Quarter displays time periods as quarter/yyyy

o Month displays time periods as mm/yyyy

o Week displays time periods as mm/dd/yyyy

Business Objective Name To specify business objectives to include in the report, select
the names from the list of business objectives in Financial
Management.

Business Unit To specify business units to include in the report, select the
names from the list of business units configured for Financial
Management.

Financial Summary Name To specify financial summaries to include in the report, select
the names from the list of financial summaries in Financial
Management.

Financial Summary Type To specify financial summary types to include in the report,
select one or more of the following from the list of financial
summary types:

o Project

o Proposal

o Asset
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Prompt

* Required Description

o Org_Unit

o Program

Region Name To specify regions to include in the report, select the names
from the list of regions configured in PPM Center.

6. From the list in the top section of the dialog box, select a prompt.

7. InfoView lists available values for some prompts in the box in the lower left portion of the dialog
box. If no values are listed for the prompt you select, click Refresh Values to display the values.

8. After you finish specifying optional data filters, click Run Query.

Web Intelligence retrieves the data for the default values and returns the results in the report.

Ad Hoc Reports for Financial Management
The FM Derived Universe delivered with PPM Center includes classes and objects that you can use to
create your own operational reports for Financial Management data. This section provides information
about the contexts available for ad hoc reports on Financial Management, the best practices for
creating reports on Financial Management data, and a description one of the many possible ad hoc
reports that you can create for Financial Management.

Contexts for Ad Hoc Reports for Financial Management

When you create an ad hoc report for Resource Management, InfoViewmay prompt you to select a
context for your report query. A context consists of a set of well-defined joins that create a unique
query path involving multiple dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a common set of dimensions,
the joins between multiple facts and the related dimensions result in a loop. By providing separate
contexts for each fact and the related dimensions, the loop is eliminated, so that you can query multiple
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports you create for Financial
Management data:
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l FA for Programs context

Use the "FA for Programs" context to create queries that include forecast and actuals data for
programs. This context includes forecast and actuals only for proposals and projects. (Assets are not
included.)

The forecast and actuals data for programs is stored at a monthly granularity. If you select the FA
for Programs context, make sure that you select the "Date range" or "Yearly Date Range" filter to
query data for a given time period.

l Approved for Programs context

The "Approved for Programs" context enables you to create report queries that include forecast
cost, actual cost, and approved costs for programs. Approved costs for proposals, projects, assets
and org units are not included.

The forecast cost, actual cost, and approved costs data for programs is stored at a yearly
granularity. If you select the Approved for Programs context, make sure that you select the "Yearly
Date Range" filter to query data for a given time period.

l FA for Proposal/Project/Asset context

The "FA for Proposal/Project/Asset" context enables you to create report queries that include
forecast and actuals for proposals, projects, and assets. Forecast and actuals data for programs
and org units are not included.

The forecast and actuals data for proposals, projects, and assets are stored at a monthly
granularity. If you select the FA for Proposal/Project/Asset context, make sure that you select the
"Date range" or "Yearly Date Range" filter to query data for a given time period.

l Approved for Proposal/Project/Asset context

The "Approved for Proposal/Project/Asset" context enables you to create report queries that include
approved costs data for proposals, projects, and assets. Approved costs data for programs and org
units are not included.

The approved costs data for proposals, projects, and assets is stored at a yearly granularity. If you
select the Approved for Proposal/Project/Asset context, make sure that you select the "Yearly Date
Range" filter to query data for a given time period.

l Approved for Org Units context
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The "Approved for Org Units" context enables you to create report queries that include cost, actual
cost, and approved costs data for org units. Approved cost data for programs, proposals, projects,
and assets are not included.

The cost, actual cost, and approved costs data for org units are stored at a yearly granularity. If you
select the Approved for Org Units context, make sure that you select the "Yearly Date Range" filter
to query data for a given time period.

Best Practices for Reporting on Financial Management Data

This section provides recommendations for getting the best results in the ad hoc operational reports
you create for your Financial Management data.

Grouping Program Measures by Business Objective When the Program has
Multiple Business Objectives

Suppose you want to construct an ad hoc report query that includes program measures (Forecast,
Actuals, Approved, and so on) grouped by business objective, and you want the query results to include
one or more objects from the Business Objectives class (in the FM Derived Universe). If you are reporting
on a program that has multiple business objectives, the resulting data for the measures are multiplied
by the number of associated business objectives. This produces incorrect report data.

To work around this issue, create a report variable that counts the number of separate business
objectives for the program. Use this variable in each ad hoc report cell that displays the program
measure, to divide the cell's total by this value. (The Financial Summary report uses this mechanism.)

Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected query filters that
retrieve a large volume of data, your query may time out and fail to return report results. To prevent
this from occurring, do one or both of the following:

l Modify the universe parameters (on the Controls tab of the Universe Parameters dialog box) to
increase the execution time limit.

l Modify the query filters to retrieve a smaller dataset.

Operational Reporting User's Guide
Chapter 3: Using BusinessObjects for Operational Reports

HP Project and Portfolio Management Center (Content Pack 2.0, on PPM Center 9.30) Page 110 of 131



Selecting Yearly Granularity for the Financial Summary Report

If you run the Financial Summary Report with Year as the selected time granularity, you must specify
the starting month of the fiscal year as the Begin Period, and the ending month of the fiscal year as the
End Period. Otherwise, the yearly values for Forecast and Actuals measures are incorrect.

Disabling Financial Summary for a Program

In Program Management, you can disable the financial summary associated with a program. (For details,
see the Program Management User’s Guide.) During the regular incremental updates of Financial
Management data, financial summary data for programs are brought over to the reporting database.
The Financial Summary report results do not include the financial summary data, but ad hoc reports
results for Financial Management do include this data.

To filter out programs with the financial summary disabled, do one of the following as you create the
report query in InfoView:

l Add the Financial Summary: Enabledfilter (FM Derived Universe, Financial Summary class) to the
Query Filters panel.

Alternatively,

1. Add the Financial Summary Enabledobject (FM Derived Universe, Financial Summary class) to the
Query Filters panel.

2. In the Query Filters panel, click the list button in the Financial Summary Enabled box (right end),
and select Prompt from the list.

3. When you run the report and are prompted for a value for Financial Summary Enabled, enter Y.

Comparing the Role of a Position and the Role of a Resource Assigned to the
Position

In creating a query that compares the role of a position with the actual role of a resource assigned to
that position, you must do the following:

l Select the Role Name object (Roles class) for the role of the position

l Select the Primary Role object (Resource class) for the role of the resource
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l Select either the "Resource Demand from Staffing Pool Region" context or the "Resource Demand
on Resource Pool Region" context.

Creating Ad Hoc Reports for Financial Management

The FM Derived Universe delivered with PPM Center includes classes and objects that enable you to
create your own operational reports for Financial Management data. The following are examples of the
ad hoc reports that you can create for your Financial Management data:

l "Assets, Proposals, and Projects by Program: Example" below

l "Over-Budget Projects, Proposals, Assets, and Programs by Date" on the next page

l "Program Lifecycle Entities and Sub-Programs" on page 116

l "Approved Budget Information for Organization Units, by Region" on page 118

l "Financial Data for Programs, Organization Units, and Lifecycle Entities (Including Data for User Data
Fields)" on page 118

Assets, Proposals, and Projects by Program: Example

A program manager can create a report that shows all of the assets, proposals, and projects associated
with her programs. "Table 6-1. FM Universe objects to include in a report on the assets, proposals, and
projects associated with programs" below lists the FM Derived universe objects to use to create this
report, and where to place them in InfoView.

Object Class Result Objects
Query Filters / Operator /
Filter Type

Fiscal Periods Year Period Name Date Range

Financial Summary > Approved Budget Approved Base

Financial Summary > Forecast & Actuals
> Costs

Forecast Base

Actual Base

Proposals, Projects and Assets
(Lifecycle Entities)

Parent Program Name

Financial Summary Name

Parent Program Name

Table 6-1. FM Universe objects to include in a report on the assets, proposals, and projects
associated with programs
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Object Class Result Objects
Query Filters / Operator /
Filter Type

Source Entity Type

Request ID

Request Status

Request Type Name

Active Workflow Step
Name

Application

Business Objective Name

Business Unit

Department

Entity Asset Class

Entity Project Class

Entity Region

Priority

Source Entity Health

Source Entity Name

Workflow Name

Table 6-1. FM Universe objects to include in a report on the assets, proposals, and projects asso-
ciated with programs, continued

Over-Budget Projects, Proposals, Assets, and Programs by Date

You can create a query for a report that shows which projects, proposals, assets, and programs exceed
the approved or forecasted budget on a given date. Before you can create this query in InfoView, you
must first use Universe Designer to create a new object in the FM Derived universe.

To create a report on projects, proposals, assets, and programs that exceed the approved or forecasted
budget on a given date:
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1. Open the FM Derived Universe in Universe Designer.

2. A Warning - Security dialog box opens to advise you of a security concern related to Java
application components and to allow you to block potentially unsafe components. Click No.

3. In the Classes and Objects panel, right-click the Costs folder (Financial Summary > Forecast &
Actuals > Costs) and select Object.

4. In the Edit Properties dialog box, name the object "Percentage Filter" and add the following
statement to the Select section:

CASE
WHEN (@Select(Costs\Forecast Base) IS NOT NULL AND @Select(Costs\Forecast
Base)!=0 ) THEN
@Select(Costs\Actual Base) / @Select(Costs\Forecast Base) * 100
END

5. Parse the select statement for syntax errors, and then save and export the FM Derived universe.

6. Log on to InfoView and create a newWeb Intelligence report query.

The following table shows the FM Derived universe objects to use for this report, where to place
them in InfoView, and how to set the query filters.
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Object Class Result Objects
Query Filters / Operator / Filter
Type

Proposals, Projects
and Assets (Lifecycle
Entities)

Entity Name

Request Id

Financial Summary Name

Entity Type

Financial Summary >
Forecast & Actuals >
Lines

Expense Type Code

Labor Type Code

Category Name

Expense Type Code / In list / Capital

Fiscal Periods Month Period Name (or other
granularity)

Date Range

Financial Summary >
Forecast & Actuals >
Costs

o Forecast Base

o Actual Base

o Forecasted vs. Actual (in %)

o Percentage Filter

o Percentage Filter / Greater than /
Constant (100)

o Exclude Snapshot & FD
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Program Lifecycle Entities and Sub-Programs

You can create a report that lists the lifecycle entities and sub-programs that are associated with your
programs. "Table 6-2. FM Universe objects to include in a report query on the lifecycle entities and sub-
programs associated with specific programs" below shows the FM Derived universe objects to use for
this report, where to place them in InfoView, and how to set the query filters.

Object Class Result Objects Query Filters / Operator / Filter Type

Proposals, Projects
and Assets (Lifecycle
Entities)

Parent Program Name

Financial Summary Name

Entity Type

Request Id

Request Status

Request Type Name

Active Workflow Step Name

Application

Business Objective Name

Business Unit

Department

Asset Class

Project Class

Region

Priority

Entity Health

Entity Name

Workflow Name

Parent Program Name / In list / Prompt

Request Information Entity Type

Fiscal Periods Year Period Name Yearly Date Range

Table 6-2. FM Universe objects to include in a report query on the lifecycle entities and sub-
programs associated with specific programs
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Object Class Result Objects Query Filters / Operator / Filter Type

Financial Summary >
Approved Budget

Approved Base

Forecast Base

Actual Base

Table 6-2. FM Universe objects to include in a report query on the lifecycle entities and sub-pro-
grams associated with specific programs, continued
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Approved Budget Information for Organization Units, by Region

You can create a report that shows approved budget information for the organization units defined in
PPM Center, based on region. "Table 6-3. FM Universe objects to add to a query for a report on approved
budget information for organization units, by region" below shows the FM Derived universe objects to
use for this report, where to place them in InfoView, and how to set the query filters.

Object Class Result Objects Query Filters / Operator / Filter Type

Approved Budget Approved Base

Direct Parent Name

Financial Summary Type

Financial Summary Type / Equal to / Value from list
> ORGANIZATION UNIT

Regions Region Name Region Name / In list / Prompt

Table 6-3. FM Universe objects to add to a query for a report on approved budget information for
organization units, by region

Financial Data for Programs, Organization Units, and Lifecycle Entities
(Including Data for User Data Fields)

You can create a report that shows the financial data for programs, organization units, and lifecycle
entities, and which includes data from user data fields configured in PPM Center. "Table 6-4. FM
Universe objects to add to a query for a report on financial information for programs, organization
units, and LCEs" below shows the FM Derived universe objects to use for this report, where to place
them in InfoView, and how to set the query filters.

Note: For information about how to add customized user data fields that exist in your PPM Center
forms to your ad hoc reports, see "Adding Customized PPM Center Data Fields to Ad Hoc
Operational Reports" on page 126.

Object Class Result Objects
Query Filters / Operator
/ Filter Type

Financial Summary > Approved Budget l Actual Base

l Direct Parent Name

Table 6-4. FM Universe objects to add to a query for a report on financial information for
programs, organization units, and LCEs
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Object Class Result Objects
Query Filters / Operator
/ Filter Type

l Financial Summary Type

l Forecast Base

Depending on the specific dimension you
want to report on, one of the following:

l Forecast & Actual > Forecast & Actual
User Configured Data > Line Level
User Configured Data (or Section
Level User Configured Data)

l Programs > Programs User
Configured Data

l Proposal, Project, Asset > Proposal,
Project, Asset & Other Requests User
Configured Data

Visible User Data
(one or more)

Visible User Data /Equal
to / Value(s) from list

Table 6-4. FM Universe objects to add to a query for a report on financial information for pro-
grams, organization units, and LCEs, continued

Reporting Portlets
l "About Operational Reporting Portlets" below

l "Adding Operational Report Portlets to PPM Dashboard Pages" on page 122

About Operational Reporting Portlets
HP supplies two PPM Center portlets — the Operational Report portlet and the Operational Report List
portlet — that enables you to access operational reports from your PPM Dashboard pages. This chapter
provides descriptions of the reporting portlets, and instructions on how to add them to your private
pages in the PPM Dashboard.

Operational Report List Portlet

The Operational Report List portlet provides a link to each of the preconfigured operational reports that
HP provides with Operational Reporting. After you click the link to a report and log on to InfoView, you
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have access to all of the linked reports and drill-down functionality associated with the selected report.

By default, the Operational Report List portlet lists the HP-supplied operational reports for Financial
Management, Project Management, Resource Management, and HP Time Management data. If your
administrator has added ad hoc reports to the portlets, you can also access these reports from the
Operational Report List portlet. "Figure 7-1. Operational Report List Portlet on a PPM Dashboard page"
below shows the Operational Report List portlet displayed on a a PPM Dashboard page.

Figure 7-1. Operational Report List Portlet on a PPM Dashboard page

Operational Report Portlet

The Operational Report portlet displays an HP-supplied operational report based on the report name
you select. After you edit your portlet preferences by selecting the name of the ad hoc report to display
and log on to InfoView, you have access to the selected report. The following figure shows the Project
Status List report displayed on a PPM Dashboard page.

Figure 7-2. Operational Report portlet on a PPM Dashboard page
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Operational Report Portlet Security

If you have the permissions required to view a report from InfoView, you can see the same report in a
reporting portlet from PPM Dashboard pages.
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Adding Operational Report Portlets to PPM Dashboard
Pages
To optimize system performance, HP strongly recommends that you add the operational report portlets
to PPM Dashboard pages that do not already display portlets belonging to categories other than
Operational Reporting.

To add an Operational Reporting portlet to a PPM Dashboard page:

1. From the PPM Center standard interface, go to (or create) the PPM Dashboard page to which you
want to add a reporting portlet.
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2. Click the Add Portlets button.
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3. From the Category list in the Add Portlets window, select Operational Reporting.

4. Select the check box for one or both portlets, and then click Add.

5. If you added the Operational Report portlet to the PPM Dashboard page, select the report for the
portlet to display as follows:
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a. In the Operational Report box, click the Edit portlet preferences icon.

The Edit Preferences page opens.

b. From the Report Name Filter list, select the name of the report to display in the portlet.

c. Click Save.

6. If you use Internet Explorer as your browser, do the following:

a. From an Internet Explorer browser window, select Tools > Internet Options.

b. Click the Security tab, and then, in the Select a zone to view or change security settings box,
click Trusted sites.

c. Click Sites.

d. In the Trusted sites dialog box, add the base URL for your BusinessObjects server.

7. From the Dashboardmenu, navigate to the PPM Dashboard page that contains the reporting
portlet(s).
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Adding Customized PPM Center Data Fields to Ad Hoc
Operational Reports
l "Adding User Data Fields to Operational Reports" below

l "Saving and Sharing Operational Reports" on page 129

Adding User Data Fields to Operational Reports
This chapter provides information about how to expose the customized user data fields that exist in
your PPM Center forms in Operational Reporting and add them to your reports. It also provides
information on how to save and share the reports your create in InfoView.

To accomplish this, you first edit a universe user data object to represent a user data field in PPM
Center, and then add the user data field to an ad hoc report (in InfoView). The following sections provide
instructions for these tasks.

Note: For information about the user data objects in the PPM Center universes, see the Data Model
Guide.

For information about how to add custom parameters to reports, see the Operational Reporting
Administrator’s Guide.
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Editing a User Data Object to Represent a User Data Field

To edit a user data object to represent a user data field that exists in
PPM Center:

1. Log on to Universe Designer and open the universe associated with the PPM Center module that
you are reporting on.

2. In the Universe panel (left panel), navigate to the subclass that contains user-configured data
objects for the PPM Center entity for which user data fields are defined.

3. Double-click the Visible User Data object that corresponds to the user data field in PPM Center. For
example, if a user data field is defined for requests in PPM Center, and that field has the user data
qualifier USER_DATA3, then, in the Universe designer Universe pane, you would navigate to the
Request User Configured Data subclass, and then double-click Visible User Data3.

The Edit Properties of Visible User Data<N> dialog box opens to the Definition tab.

4. In the Name box, replace the existing value with the name of the user data field defined in PPM
Center.

5. Click OK, and then save the file.

6. Repeat step 2 through step 4 for each additional user data field that you want to include in your
operational reports.

7. Save the modified universe to the BusinessObjects repository, as follows:

a. Click File > Export.

The Export Universe dialog box opens.

b. To export the universe to a folder other than the one displayed in the Domain box, click
Browse, and then locate and select a different domain.

c. In the Group box, select the group or groups that require access to the exported universe. (In
the Universes list, the modified universe is selected by default.)

Universe Designer displays a message that confirms the export operation.

Users can now access the modified universe objects in InfoView.
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8. Log on to InfoView and open the Web Intelligence report document to which you want to add the
user data field(s).

9. In the Prompts dialog box, select values for any required prompts, and then click Run Query.

10. In the InfoView toolbar, click Edit.

11. In the Web Intelligence toolbar, click Edit Query.

The Data tab in the Universe pane now lists all of the objects in the universe that you modified and
exported.

a. To add the user-configured object for the user data field as a report query filter and set the
prompt properties:

b. On the Data tab, select the object, and then drag and drop it into the Query Filters section (on
the right) where you want it to be listed in the Prompts dialog box relative to the other
prompts.

c. To change the query operator for the prompt, select an operator from the list of operators.

d. On the prompt object in the Query Filters section, click Prompt properties.

The Prompt dialog box opens.

e. Set the properties for the prompt, and then click OK.

12. On the report results page, drag the fields to where they make sense in the report.

Editing an Ad Hoc Report to Include a User Data Field

To edit an ad hoc report to include a user data field:

1. Log on to InfoView and open the Web Intelligence document for the report.

2. Add a new filter for a staffing profile line user data field, and incorporate into report queries.

3. Add a new display column and for a staffing profile line user data field, and incorporate into the
report.

4. Add a new grouping mechanism for a staffing profile line user data field, and incorporate into the
report.
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5. Add a new filter for a resource pool user data field, and incorporate into report queries.

6. Add a new display column and for a resource pool user data field, and incorporate into the report.

7. Add a new grouping mechanism for a resource pool user data field, and incorporate into the report.

8. Run the report query.

Saving and Sharing Operational Reports
If your report viewers use InfoView, you can save your operational reports as public documents and send
them directly to stakeholders. You can also schedule documents for automated refresh and distribution
at a time and date you specify. To share reports with viewers who do not use InfoView, you can send
reports as Microsoft Excel, PDF and Web Intelligence documents as email attachments that recipients
can view and print. You can save a report (Web Intelligence document) in InfoView as a file in any of the
following formats:

l Excel spreadsheet

l PDF file

l CSV (comma-separated-value) file

To save the results of a report to your computer as an Excel spreadsheet or PDF file:

l Select Document > Save report to my computer as, and then select Excel or PDF.

Limitation on Saving a Report as an Excel Spreadsheet

BusinessObjects uses its own internal libraries to generate Excel documents. (The version of Excel that
you have installed locally is irrelevant.) These internal libraries create a document with the same row
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and column limitations as Excel 2003. Regardless of which version of Excel you use to view the exported
report results, data are missing.

Workaround

To work around the limitation imposed on exporting report results to an Excel spreadsheet, save the
report in txt format, and then import the text document into Excel 2007. Note that, although the
resulting data are complete, formatting is lost.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Operational Reporting User's Guide (Project and Portfolio Management Center Content
Pack 2.0, on PPM Center 9.30)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a newmessage in a web mail client, and
send your feedback to HPSW-BTO-PPM-SHIE@hp.com.

We appreciate your feedback!
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